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Resumo 
A presente dissertação foi desenvolvida no âmbito do tema do reforço à flexão de vigas de betão armado 

com laminados de CFRP aplicados com técnica NSM. A realização deste trabalho permitiu efetuar a 

modelação do comportamento de um conjunto de vigas de betão armado, reforçadas à flexão com a 

referida técnica de reforço, usando software de elementos finitos. Além disso, foi realizado um estudo 

paramétrico para avaliar a influência de um conjunto de parâmetros na eficácia da técnica NSM com 

laminados de CFRP no reforço à flexão de vigas de betão armado.  

Numa primeira fase foi feita uma revisão bibliográfica sobre o estado do conhecimento atual no que diz 

respeito ao reforço de vigas de betão armado com materiais compósitos de CFRP, com particular destaque 

para a técnica NSM com laminados de CFRP. Posteriormente, procedeu-se à modelação do 

comportamento de um conjunto de vigas de betão armado reforçadas à flexão com laminados de CFRP 

aplicados com a técnica NSM, ensaiadas experimentalmente no Laboratório de Estruturas (LEST) do 

Departamento de Engenharia Civil da Universidade do Minho. Para a referida modelação foi usado o 

software de elementos finitos femix e o GID. Após a calibração do modelo numérico, foi efetuado um 

estudo paramétrico para avaliar a influência dos seguintes parâmetros na eficácia da técnica NSM com 

laminados de CFRP no reforço à flexão de vigas de betão armado: classe de resistência do betão, 

percentagem de armadura longitudinal existente e percentagem de reforço de CFRP. Finalmente, são 

apresentadas as conclusões mais importantes deste trabalho e são indicadas algumas sugestões para 

trabalhos futuros. 

 

 

Palavras-chave: Vigas de betão armado; Reforço à flexão; Laminados de CFRP; Técnica da 

inserção; Comportamento experimental; Modelação numérica; Estudo paramétrico. 
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Abstract 
The present dissertation was developed under the theme of flexural strengthening of reinforced 

concrete beams with CFRP laminates applied with NSM technique. The realization of this work 

allowed the behaviour modelling of a set of strengthened reinforced concrete beams with the 

referred reinforcement technique using finite element software. In addition, a parametric study 

was carried out to evaluate the influence of a set of parameters on the effectiveness of the NSM 

technique with CFRP laminates in the strengthened reinforced concrete beams. 

In a first phase, a bibliographical review was made on the current state of knowledge regarding 

the strengthened reinforced concrete beams with CFRP composite materials, with particular 

emphasis on the NSM technique with CFRP laminates. Later, the behaviour of a set of 

strengthened reinforced concrete beams with CFRP laminates applied with the NSM technique, 

experimentally tested in the Laboratory of Structures (LEST) of the Department of Civil 

Engineering of the University of Minho, was carried out. The finite element software femix and 

the software GID were used for this modelling. After calibration of the numerical model, a 

parametric study was carried out to evaluate the influence of the following parameters on the 

effectiveness of the NSM technique with CFRP laminates in the strengthening of reinforced 

concrete beams: concrete strength class, percentage of existing longitudinal reinforcement and 

percentage of CFRP strengthening. Finally, the most important conclusions of this work are 

presented and some suggestions for future work are indicated. 

 

Keywords: Reinforced concrete beams; Flexural strengthening; Carbon fibre reinforced 

polymers (CFRP) laminates; NSM technique; Experimental behaviour; Numerical simulation; 

Parametric study. 
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Capítulo 1 
Introdução 

1.1 - Considerações Gerais 

A necessidade de reforçar estruturas impulsionou o desenvolvimento das técnicas de reforço 

com materiais de elevado desempenho, designadamente os compósitos de FRP (Fiber 

Reinforced Polymer - Polímeros Reforçados com Fibras). No âmbito do reforço de estruturas 

de betão armado, o FRP mais utilizado é designado por CFRP (Carbon Fiber Reinforcement 

Polymer - Polímeros Reforçados com Fibras de Carbono).  

Os CFRP possuem características de elevado desempenho mecânico (elevada rigidez e 

resistência à tração), são materiais com baixo peso específico e apresentam elevada resistência 

à corrosão. Além disso, são materiais fornecidos com uma inúmera quantidade de soluções em 

termos de dimensões, verificando-se que em alguns casos existe uma enorme facilidade em se 

adaptarem a superfícies curvas (grande vantagem comparativamente com as soluções de reforço 

com chapas de aço). Uma vez que os CFRP são materiais leves e têm características mecânicas 

de elevado desempenho, comparativamente com os materiais de reforço tradicionais, a 

quantidade de material de reforço a utilizar será menor, fazendo com que as alterações a nível 

arquitetónico sejam também menores. Além das mencionadas vantagens, refira-se o facto de os 

CFRP serem facilmente transportáveis, serem de fácil e rápida aplicação e de às técnicas de 

reforço com CFRP estarem associados baixos custos de manutenção durante a vida útil da 

estrutura reforçada. 

O reforço à flexão de estruturas de betão armado utilizando os materiais compósitos CFRP pode 

ser executado usando a técnica da colagem externa (EBR - Externally Bonded Reinforcement) 

e a técnica da inserção do CFRP no betão de recobrimento (NSM - Near Surface Mounted). A 

investigação experimental realizada até ao presente tem vindo a demonstrar a melhor eficácia 

da técnica NSM em relação à técnica EBR. Para tal, contribui o facto de a área de colagem 

usando a técnica NSM ser o dobro da área de colagem usando a técnica EBR, o que proporciona 

um significativo aumento do grau de fixação do reforço de CFRP e, consequentemente, uma 

mobilização de tensões mais elevadas no CFRP aquando da rotura do elemento reforçado, 

mostrando que existe melhor aproveitamento das potencialidades do CFRP. 

No Departamento de Engenharia Civil da Universidade do Minho, tem vindo a ser feita 

investigação no âmbito do reforço à flexão de elementos estruturais de betão usando a técnica 
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NSM com laminados de CFRP. A presente dissertação insere-se no seguimento desta linha de 

investigação. 

1.2 - Objetivos do trabalho 

De um modo geral, com a presente dissertação, pretende-se modelar o comportamento de vigas 

de betão armado reforçadas à flexão com laminados de CFRP inseridos (técnica NSM), 

ensaiadas experimentalmente no Laboratório de Estruturas (LEST) do Departamento de 

Engenharia Civil da Universidade do Minho. Para a referida modelação será usado o software 

de elementos finitos femix e o GID. Após a calibração do modelo numérico será efetuado um 

estudo paramétrico para avaliar a influência dos seguintes parâmetros na eficácia da técnica 

NSM com laminados de CFRP no reforço à flexão de vigas de betão armado: classe de 

resistência do betão, percentagem de armadura longitudinal existente e percentagem de reforço 

de CFRP. 

1.3 - Organização da dissertação 

A dissertação apresentada é composta por 6 capítulos. 

No Capítulo 1 (Introdução) é efetuado o enquadramento da temática da dissertação, são 

apresentados os objetivos a serem alcançados com a realização deste trabalho e é descrita a 

organização da dissertação.  

No Capítulo 2 (Revisão bibliográfica) é apresentado o trabalho de pesquisa bibliográfica 

efetuada relativa ao tema desta dissertação. Após uma breve referência às técnicas 

tradicionalmente utilizadas para reforçar estruturas de betão armado, foi dado particular relevo 

às técnicas de reforço com materiais compósitos de CFRP. Assim, após uma referência a estes 

materiais de elevado desempenho foram apresentadas as técnicas existentes (EBR e NSM) 

utilizando CFRP como material de reforço, assim como as vantagens e desvantagens da 

utilização destas técnicas de reforço. Tendo como base investigação experimental realizada até 

ao presente, a parte final do capítulo é dedicado ao comportamento estrutural de vigas de betão 

armado reforçadas à flexão usando laminados de CFRP aplicados com a técnica NSM.  

No início do Capítulo 3 (Modelação numérica de vigas de betão armado reforçadas à flexão 

com laminados de CFRP inseridos - GID/femix) é apresentado todo o procedimento que 

conduziu à calibração do modelo numérico e modelação do comportamento de vigas de betão 

armado reforçadas à flexão com laminados de CFRP inseridos utilizando o software de 

elementos finitos femix (Azevedo e Barros, 1998) e o GID (Coll et al., 2016). Concretamente, 



Capítulo 1 3 

 

 

 

foi efetuada a modelação do comportamento de quatro vigas ensaiadas experimentalmente no 

Laboratório de Estruturas (LEST) do Departamento de Engenharia Civil da Universidade do 

Minho (Dias et al., 2012) que tinham previamente sido ensaiadas  

Na primeira parte do Capítulo 4 (Resultados Numéricos vs. Resultados Experimentais e Estudo 

Paramétrico) é efetuada uma comparação entre os resultados obtidos experimentalmente e os 

resultados obtidos numericamente em termos do comportamento estrutural das vigas 

anteriormente referidas. Na segunda parte deste capítulo apresentam-se os resultados de um 

estudo paramétrico realizado com o modelo numérico já calibrado. Neste estudo paramétrico 

foi avaliada a influência da classe de resistência do betão, da percentagem de armadura 

longitudinal existente e da percentagem de reforço de CFRP na eficácia da técnica NSM com 

laminados de CFRP no reforço à flexão de vigas de betão armado. 

No Capítulo 5 (Conclusões gerais e desenvolvimentos futuros) são apresentadas as conclusões 

gerais resultantes do trabalho de investigação realizado. Neste capítulo também são 

apresentadas propostas para desenvolvimentos futuros. 

No Capítulo 6 (Referências bibliográficas) estão apresentadas as referências bibliográficas que 

serviram de base à realização desta dissertação.
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Capítulo 2 
Revisão bibliográfica 

2.1 - Materiais compósitos de CFRP no reforço de estruturas de betão armado 

2.1.1 - Introdução aos FRP 

As estruturas de betão armado, são projetadas para um período de vida útil previamente 

determinado, consoante o pretendido. Durante este tempo, a estrutura deve garantir níveis 

adequados de segurança, funcionalidade e durabilidade. No entanto, por vezes surgem 

situações, quer durante a fase construtiva, quer durante a fase de vida útil da estrutura, que 

fazem com que se tenha de aplicar um reforço para que os requisitos de segurança sejam 

garantidos. 

Durante a fase construtiva, podem surgir situações que originem a necessidade de intervenção 

de reforço numa determinada estrutura: devido a erros a nível do projeto de estabilidade, devido 

à aplicação de materiais com características inferiores às estabelecidas pelo projetista ou a erros 

de execução. Quando uma estrutura se encontra na fase de vida útil, podem surgir ocorrências 

que ponham em causa a segurança da mesma e por conseguinte podem originar a necessidade 

de reforço da estrutura: ocorrência de sismos, ocorrência de ações de acidente (choques, 

incêndios, explosões, atos de vandalismo), modificação da função da estrutura para condições 

mais desfavoráveis, redução da resistência dos materiais resultante da sua degradação 

(carbonatação do betão e corrosão das armaduras). Também pode haver necessidade de reforçar 

estruturas para fazer face a novas disposições regulamentares mais severas. 

Em função da deficiência estrutural, deve-se proceder à elaboração de um conjunto de 

procedimentos de avaliação para que o tipo de intervenção na estrutura a utilizar seja a mais 

adequada. Existem diferentes tipos de intervenção que usualmente são utilizados, tais como: 

demolição total ou parcial da estrutura; imposição de medidas restritivas no seu uso; 

modificação do seu sistema estrutural; substituição ou introdução de novos elementos 

estruturais; ou reforço de elementos estruturais. A escolha do tipo de intervenção passará 

naturalmente por uma análise técnica e económica. Em inúmeros casos a solução mais viável é 

reforço estrutural. Neste contexto, refira-se a necessidade cada vez mais crescente de reforçar 

estruturas de betão armado.  

Dada esta emergente necessidade de reforço das estruturas de betão armado, a procura do 

material e da técnica de reforço “ideais” tem sido cada vez mais investigada.  
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a. Encamisamento metálico das secções (Júlio, E., 

2012). 

b. Pré-esforço exterior da Ponte da Figueira da 

Foz (Costa, A., 2014). 

Figura 2.1 - Diferentes tipos de reforço de estruturas de betão armado. 

A necessidade do reforço de estruturas de betão não é recente. Assim, foram desenvolvidas 

algumas técnicas de reforço estrutural utilizando o aço como material de reforço principal, 

nomeadamente: colagem de chapas metálicas, encamisamento das secções e aplicação de pré-

esforço exterior, tal como se pode observar na Figura 2.1.                                                                                                 

A técnica mais utilizada tem sido a colagem de chapas metálicas, cuja eficácia é condicionada 

pela sensibilidade do aço ao fenómeno da corrosão, o que afeta diretamente a zona de colagem 

da interface betão-cola-aço, fazendo com que esta se deteore relativamente rápido. Esta técnica 

apresenta mais uma desvantagem referente à dificuldade do manuseamento de chapas de 

grandes dimensões, devido ao seu elevado peso próprio. 

O encamisamento metálico das secções também tem vindo a ser utilizado quando se pretende 

aumentar a ductilidade, a resistência e a rigidez. Como principal desvantagem desta técnica, 

surge o facto de se ter de aumentar consideravelmente as secções transversais e por sua vez 

aumenta-se as cargas permanentes. Esta técnica condiciona bastante a zona da obra durante o 

reforço o que também é considerado um aspeto menos positivo. 

A técnica da aplicação de pré-esforço exterior é utilizada para que haja um controlo da 

capacidade carga assim como um controlo da deformação. Apresenta como principais 

desvantagens a necessidade de proteger as armaduras de pré-esforço à corrosão, do fogo e 

também de atos de vandalismo. É necessário elaborar sistemas de ancoragens, o que poderá 

criar um acréscimo de esforços nos elementos não reforçados, utilizando esta técnica. 

Analisando estas três técnicas de reforço de estruturas de betão armado correntemente 

utilizadas, pode-se concluir que a origem da maioria dos seus aspetos negativos acima 

mencionados tem base na utilização do aço como material de reforço. A par da constatação dos 

aspetos negativos associados às técnicas de reforço tradicionalmente utilizadas, foram 

desenvolvidos novos materiais de elevado desempenho, mais conhecidos como FRP (Fiber 

Reinforcement Polymer-polímeros reforçados com fibras).  
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Os materiais compósitos de FRP são compostos por fibras embebidas num material de matriz 

polimérica. Existem três grandes tipos de fibras nos FRP que se utilizam na Engenharia Civil, 

nomeadamente as de aramida (A), carbono (C) e vidro (G). Cada uma destas fibras tem o seu 

próprio compósito, designadamente o AFRP (Aramid Fiber Reinforcement Polymer – Polímero 

Reforçado com Fibras de Aramida), o CFRP (Carbon Fiber Reinforcement Polymer – Polímero 

Reforçado com Fibras de Carbono) e o GFRP (Glass Fiber Reinforcement Polymer – Polímero 

Reforçado com Fibras de Vidro). As fibras poder ser colocadas apenas numa direção ou em 

várias direções: se forem colocadas numa direção o compósito é denominado como FRP 

unidirecional, se forem colocadas em várias direções o compósito é denominado FRP 

multidirecional. No caso dos compósitos de FRP unidirecionais, a orientação unidirecional das 

fibras confere ao FRP a maximização da rigidez e da resistência na direção longitudinal das 

fibras. 

Comparando os três tipos de fibras anteriormente mencionados, destacam-se as fibras de 

carbono porque apresentam as seguintes vantagens comparativamente às fibras de aramida e de 

vidro (ver Tabela 2.1 e a Figura 2.2): melhores propriedades mecânicas tais como maior rigidez 

(Ef) e maior resistência à tração (ffu); são mais resistentes a ataques químicos; imunes de 

corrosão; não absorvem água. As fibras de vidro apresentam um menor custo, uma menor 

resistência à fadiga e um maior peso específico. As fibras de aramida apresentam maior 

dificuldade de moldagem, são mais sensíveis à fluência e têm baixa resistência à compressão. 

Considerando as vantagens das fibras de carbono, anteriormente referidas, comparativamente 

com os outros tipos de fibras, é de fácil compreensão o porquê de serem as mais utilizadas a 

nível do reforço de estruturas de betão armado. Neste contexto, o estudo efetuado na presente 

dissertação está direcionado para o uso de compósitos de CFRP. 

Tabela 2.1 - Propriedades dos AFRP, GFRP e CFRP (adaptado de Juvandes e Reis, 2012). 

Propriedades AFRP GFRP CFRP 

ρ (g/cm3) 1,30 - 1,45 1,73 - 2,18 1,43 - 1,67 

Ef (GPa) 40 - 125 35 - 60 100 - 580 

σfu (MPa) 1000 - 2540 450 - 1600 600 - 3690 

εfu (%) 1,9 - 4,4 1,2 - 3,7 0,5 - 1,7 
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Figura 2.2 - Diagrama tensão vs. extensão de diferentes tipos de fibras: carbono HM, carbono HS, 

aramida e vidro, aço convencional (A500) e cordões de aço de pré-esforço (adaptado de ACI 440R-96 

(1996)). 

A matriz é a segunda componente dos materiais compósitos. Esta tem como principais funções 

garantir que as fibras funcionem em conjunto, não deixar que as fibras se danifiquem por 

agentes exteriores ao compósito e proteger o compósito dos fenómenos de instabilidade. 

Quando se trata de um material compósito, temos de ter em conta a sua matriz e o seu reforço. 

Tal como se pode observar na Figura 2.3, a matriz de um material compósito pode ser 

polimérica, cerâmica ou metálica. No caso dos FRP, a matriz é do tipo polimérica e assim os 

FRP são constituídos por uma matriz polimérica reforçada com fibras. A matriz polimérica dos 

FRP pode ser termoplástica ou termoendurecível. Caso seja termoplástica, esta quando é 

aquecida, funde assumindo formas específicas que mantem quando arrefecida. A matriz 

polimérica termoendurecível tem como vantagens: elevada aderência a outros materiais, 

elevada resistência mecânica; não absorve água. Deste modo, analisando as vantagens e 

desvantagens de ambas as matrizes, a matriz polimérica mais utilizada é a termoendurecível, 

mais propriamente do tipo epóxi. 

 

                                                      Matriz                               

                                                                                               - Termoendurecíveis (Epoxy, poliimidas (PI), Fiberglass) 

                                                                                               - Termoplásticos (polipropileno, poliamidas, policarbonato) 

                                                                                               - Elastoméricas (fillers – partículas coloidais) 

 

                                                                                               - Adicionam-se fibras durante a sinterização (fibras de vidro, 

                                                                                                 carbono e carboneto de silício)           

                                                                                               

                                                                                               - Ligas metálicas leves (alumínio, magnésio ou titânio) 

 

Figura 2.3 - Diferentes tipos de matriz dos materiais compósitos. 

Materiais 

Compósitos 

 

Polimérica 

Cerâmica 

Metálica 
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Existem dois sistemas de comercialização dos CFRP para o reforço de estruturas de betão 

armado: os sistemas pré-fabricados e os sistemas curados “in situ”. Os sistemas pré-fabricados 

são compostos por laminados e varões unidirecionais; os sistemas curados “in situ” são 

compostos por mantas (sistema unidirecional) ou tecidos (sistema multidirecional), tal como se 

pode observar na Figura 2.4.  

 

Figura 2.4 - Materiais compósitos de CFRP (Dias, 2008). 

A comercialização dos CFRP é um tema que tem merecido especial atenção pois está a ser feito 

um esforço por forma a encontrar novas estratégias para reduzir o preço final do CFRP. Com 

efeito, o preço dos CFRP ainda é um entrave para a sua utilização no reforço de estruturas de 

betão armado. No entanto, o preço dos materiais não deve ser o único critério de escolha de 

uma técnica de reforço. Se for tido em conta aspetos como o baixo custo de instalação/execução 

associado à utilização de CFRP; facilidade de transporte e aplicação dos CFRP devido ao seu 

baixo peso; a necessidade de poucos elementos de suporte (andaimes) e pouca mão-de-obra “in 

situ” quando o reforço é feito com CFRP; baixos custos de manutenção durante vida útil em 

virtude dos CFRP serem materiais duráveis e imunes à corrosão. Além de todos estes fatores, 

acrescenta-se o facto da utilização dos CFRP estar a aumentar. Brito Junior (2011) apontou um 

aumento na utilização destas fibras nos próximos anos em cerca de 13% por ano, fazendo com 

que o preço base unitário deste diminua, enquanto que o custo do aço tem aumentando ao longo 

do tempo.  No entanto, 51% do custo das fibras de carbono estão associadas ao custo do 

processo de obtenção das fibras de poliacrilonitrila (PAN), precursoras de fibras de carbono, 

utilizadas posteriormente no processo de pirólise (decomposição do material rico em carbono 

usando calor) e posteriormente na grafitização, processo este que proporciona uma 

“cristalização” ordenada dos cristais de carbono no interior da fibra. As fibras de carbono 

utilizadas estão associadas diretamente ao custo do petróleo, logo, se houver uma aposta maior 

nas energias renováveis e sustentáveis, o preço do petróleo irá descer visto que a procura será 

menor, e por sua vez, o custo da produção de fibras de carbono será menor, logo o custo final 

do compósito de CFRP será menor. Para que o custo das fibras de carbono baixe ainda mais, 
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no laboratório nacional de Oak Ridge no Tennessee (EUA), a lignina poderá vir a ser um 

precursor das fibras de carbono bastante viável visto que oferece um menor custo de produção 

comparativamente com ao precursor de PAN (cerca de 50% do custo da PAN), embora quando 

testada em laboratório, tenham tido uma menor resistência à tração, comparadas com as PAN 

(cerca de 4 vezes menos que a PAN). Com o avançar do tempo, o processo de fabrico das fibras 

de carbono será cada vez mais otimizado, fazendo com que o preço desça e se torne ainda mais 

competitivo relativamente ao aço e a outros materiais de reforço. 

2.1.2 - Comparação entre os CFRP e o aço no reforço de estruturas de betão armado 

As principais vantagens dos CFRP comparativamente ao aço no reforço de estruturas de betão 

armado são a elevada resistência à corrosão, o baixo peso específico e a excelente relação 

resistência à tração/peso específico. Relativamente à primeira vantagem, os CFRP solucionam 

o problema da corrosão associado às chapas de aço e as suas consequências em termos da 

segurança da estrutura de betão armado reforçada. O baixo peso específico dos compósitos de 

CFRP é outro fator que tem uma elevada importância uma vez o peso específico do CFRP é 

aproximadamente 20% do peso específico do aço (Figura 2.5). O baixo peso específico dos 

CFRP facilitam o seu transporte, manuseamento e instalação em obra, o que é uma enorme 

vantagem em termos económicos. Por último, o elevado valor da relação resistência à tração/ 

peso específico o que proporciona soluções leves com elevado desempenho.  

 

Figura 2.5 - Comparação entre os materiais CFRP e o aço. 

2.2 - Técnicas de reforço usando materiais compósitos de CFRP 

As técnicas de reforço usando materiais compósitos de CFRP podem-se dividir em dois grupos: 

colagem externa do CFRP (laminados, mantas, …) e inserção de varões ou laminados de CFRP 

em entalhes efetuados no betão de recobrimento. A primeira técnica é designada na literatura 

internacional por EBR (Externally Bounded Reinforcement), enquanto a segunda técnica é 

designada na literatura internacional por NSM (Near Surface Mounted).  
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2.2.1 - Técnica de colagem externa (EBR Externally Bonded Reinforcement) 

A técnica de colagem externa foi a primeira a ser investigada cientificamente e a mais utilizada 

em termos de casos de obra (Figura 2.6). O reforço de elementos de betão armado com materiais 

compósitos de CFRP aplicados com a técnica EBR envolve as três fases seguintes (Juvandes et 

al., 2003): 

 Preparação da superfície na zona da estrutura onde o reforço será aplicado, de modo a 

garantir boas condições de aderência do CFRP ao betão. No sistema curado “in situ”, a 

superfície deve ser esmerilada. No caso do sistema pré-fabricado unidirecional, a superfície 

do elemento deve ser bojardada com jatos de areia ou picotada com um martelo de agulhas. 

Após este primeiro passo, a superfície deve ser limpa por intermédio da aplicação de ar 

comprimido. Em alguns sistemas de reforço é aconselhável, posteriormente às tarefas 

anteriormente descritas, a aplicação de uma camada de primário. 

 Colagem do reforço de CFRP; 

 Controlo da qualidade da técnica de reforço antes, durante e após a aplicação do CFRP. 

Para que o terceiro tópico seja aprovado, os dois primeiros tópicos têm de ser cumpridos com 

rigor. Caso haja um teor de humidade elevado na superfície do elemento a reforçar, a aderência 

betão-primário não será adequada e por sua vez, o reforço terá uma perda de eficiência 

(Juvandes et al., 2003). Outro exemplo é relativamente à limpeza dos laminados, visto que caso 

não se utilize um desengordurante adequado (sem acetona), poderá originar uma ineficiência 

no reforço (Dias et al., 2002). 

   

a) b) c) 

Figura 2.6 - Aplicação da técnica EBR utilizando CFRP (Alkhrdaji, T., 2015). 
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Existe um conjunto de medidas a serem aplicadas antes, durante e após a aplicação do reforço 

de CFRP, com o objetivo de minimizar os riscos de se efetuar um deficiente reforço. As medidas 

são as seguintes (Bettor, 2003; Carolin, 2003; Eurocomp, 1986; Juvandes, 1999 e Sika, 2001): 

 Deve ser efetuada a avaliação da qualidade do betão superficial do elemento a reforçar 

através de ensaios de tração direta de “pull off”. Segundo o ACI Committee 440 (2002), para 

que se possa aplicar a técnica de colagem externa (EBR), o valor mínimo recomendável da 

resistência à tração superficial deve ser de 1.4 MPa: 

 Devem ser tratadas todas as irregularidades da superfície utilizando o “putty” (resina de 

regularização de superfície); 

 Após a limpeza da base de betão, o teor máximo de humidade desta não deve exceder 4%; 

 Na altura da aplicação do reforço a humidade relativa da superfície de betão não deve ser 

superior a 80%; 

 A temperatura do ar deve ser, no mínimo, de 10ºC e superior, em 3ºC, à temperatura que 

origina a formação de orvalho; 

 É recomendado a fixação de um limite superior para a amplitude térmica esperada numa 

aplicação normal da construção (Tc) de valor igual ao da temperatura de transição vítrea (Tg) 

das resinas ou dos adesivos, reduzido de 10ºC a 20ºC [Tc ≅ Tg -10ºC (a 20ºC)]; 

 A mistura da resina e do endurecedor, fornecidas pelo fabricante, devem ser efetuadas, 

cumprindo com as especificações técnicas a nível de dosagens e do modo de mistura; 

 Deve-se cumprir o tempo prático de utilização (pot-life) dos adesivos e das resinas. O Pot-

life corresponde ao tempo que demora uma mistura a duplicar a sua viscosidade ou o 

quadruplo, no caso de materiais com pouca viscosidade. O tempo começa a ser contado a 

partir do momento que o produto é misturado; 

 Quando são aplicados os sistemas de manta, deve-se ter em atenção o alinhamento das fibras 

e deve-se evitar a formação de bolhas de ar; 

 Após a colagem do laminado, deve-se verificar, aplicando pancadas suaves, que não existem 

vazios entre o laminado e o adesivo; 

 Para que se proteja a matriz da ação dos raios ultravioletas, deve-se pintar o reforço com 

tintas adequadas ao efeito pretendido. 
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2.2.2 - Técnica de inserção de varões ou laminados de CFRP (NSM Near-surface Mounted) 

No passado, a técnica NSM já foi utilizada, mas em vez de se utilizar laminados ou varões de 

CFRP, utilizavam-se varões de aço (Asplund, 1949). O facto de os CFRP serem resistentes à 

corrosão permite que os entalhes tenham profundidades inferiores às necessárias para o caso 

dos varões de aço, o que facilita a instalação dos laminados, diminuindo também o risco de 

interferir com as armaduras existentes para a aplicação da técnica NSM com CFRP (Figura 2.7 

no caso do reforço à flexão de uma viga de betão armado), o procedimento a cumprir é o 

seguinte (Dias, 2008): 

a. Execução do entalhe na face do elemento a reforçar; 

b. Limpeza do entalhe efetuado com a aplicação de ar comprimido; 

c. Corte do CFRP e posteriormente limpeza deste com acetona; 

d. Produção do adesivo epoxy seguindo os procedimentos do fornecedor; 

e. Preenchimento do entalhe com adesivo; 

f. Aplicação do adesivo também nas faces do CFRP para que haja uma colagem homogénea; 

g. Introdução do CFRP no entalhe, retirando o adesivo em excesso. 

 

       

     

Figura 2.7 - Procedimento da aplicação da técnica NSM utilizando CFRP (adaptado de Dias et al. 

(2012) e Dias et al. (2014)). 

As secções transversais dos CFRP mais utilizadas no reforço de estruturas de betão armado 

com a técnica NSM são as seguintes (Figura 2.8): circular (varões nervurados ou varões com 

superfície rugosa), quadrada e retangular (laminados com umas das dimensões bastante maior 

que a outra). 
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a) 1. varões nervurados, 1.1. varões com superfície rugosa, 

2. quadrada, 3. Retangular. 

b) Tipos de CFRP usados na técnica 

NSM (De Lorenzis e Teng, 2007). 

Figura 2.8 - Diferentes tipos de secções transversais dos CFRP para aplicações da técnica NSM. 

El-Hacha e Rizkalla (2004), após o seu estudo e investigação, depararam-se com um problema 

visto que demasiadas vigas reforçadas com varões de CFRP, quando ensaiadas à flexão, sofriam 

roturas por deslizamento ou deslocamento dos varões de CFRP em contacto com o betão de 

recobrimento. Com os valores obtidos destas experiências, concluíram que seria pouco o 

aproveitamento em reforçar vigas de betão armado com varões de CFRP e não de aço. Foi então 

que decidiram ensaiar em vigas de betão armado, laminados de CFRP em substituição dos 

varões de CFRP. Após efetuarem os ensaios laboratoriais e ser retiradas a devidas conclusões, 

a solução mais eficaz para os autores foram os laminados. As principais justificações que 

apresentaram foram que, com os laminados, houve um maior aproveitamento do material de 

reforço e o descolamento/deslizamento dos laminados CFRP acontecia para um valor de tensão 

máxima de rotura superior aos dos varões. Isto deveu-se ao facto da área de colagem dos varões 

ser baixa comparativamente à área de colagem dos laminados com o entalhe feito previamente 

à medida da secção transversal do compósito. Logo, conclui-se que mesmo que possa exigir 

uma profundidade maior do betão de recobrimento, a forma geométrica dos laminados CFRP é 

a mais indicada para que haja um melhor aproveitamento da técnica NSM numa estrutura de 

betão armado. 

Os parâmetros que condicionam a eficiência do reforço de estruturas de betão usando a técnica 

NSM são a geometria do elemento a reforçar, a percentagem de armadura longitudinal, a 

percentagem de CFRP, a classe de resistência do betão, o tipo de carregamento da estrutura a 

reforçar, o espaçamento entre laminados CFRP adjacentes e a distância do laminado à face do 

elemento a reforçar. Alguns destes parâmetros e respetiva influência na eficácia da técnica NSM 

com laminados de CFRP no reforço à flexão de vigas de betão armado serão objeto de análise 

no âmbito do quarto capítulo desta dissertação. 
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Kotynia e Cholostiakow (2015) investigaram sobre a eficácia do uso de laminados com secção 

em forma de “T”. Nesta investigação foram ensaiadas 9 vigas de betão armado com dimensões 

270mm×550mm×4000mm (largura da seção transversal × altura da seção transversal × 

comprimento das vigas), tendo como armadura longitudinal dois varões de 12mm (212) e dois 

varões de 14mm (214), respetivamente, em termos de armadura de compressão e de tração. A 

nível de estribos foram utilizados varões de 8mm espaçados de 100 mm e de 200 mm, 

respetivamente, perto dos apoios e nos 1200mm centrais da viga. Após a análise dos resultados 

obtidos, foram retiradas algumas conclusões: i) existiram aumentos de 86% até 250% na 

capacidade de carga máxima das vigas reforçadas com laminados de CFRP, comparativamente 

com a viga de referência; ii) quanto mais profundo foi colocado o laminado em T, maior foi a 

extensão do CFRP e maior foi também a resistência ao deslizamento/descolamento do 

laminado; iii) quanto maior a percentagem de CFRP utilizado no reforço de uma viga de betão 

armado, maior foi o acréscimo da capacidade de carga máxima, mas em contrapartida, menor 

foi a extensão do CFRP.  

Um ano mais tarde, Rezazadeh et al. (2016), publicaram um artigo com o intuito de fornecer 

um acréscimo de informação da aplicação da técnica NSM utilizando CFRP para reforço de 

estruturas de betão armado com laminados em forma de T. Estes autores ensairam à flexão 

cinco vigas de betão armado (Ref, 1T-15, 2T-15, 1T-30, 2T-30), tal como se pode observar na 

Figura 2.9. Nas vigas 1T-30 e 2T-30 foram cortados os ramos inferiores dos estribos das vigas, 

para que fosse possível inserir os perfis de CFRP no betão de recobrimento, visto que este não 

tinha altura suficiente relativamente à altura dos laminados. Após a realização destes ensaios 

foi possível avançar com algumas conclusões relacionadas com esta nova vertente da aplicação 

da técnica NSM: i) os perfis de CFRP adotados aumentaram substancialmente a capacidade de 

carga máxima das vigas de betão armado, variando esse aumento entre os 114,6% e 252,01% 

comparativamente à viga de referência; ii) aumentando o número de laminados de CFRP em 

forma de T, a carga máxima e a rigidez da viga aumentaram, enquanto que o nível máximo de 

extensão instalado nos perfis de CFRP diminuiu; iii) quanto maior for a alma dos laminados de 

CFRP em forma de T  (Figura 2.9b), maior é a extensão máxima no CFRP e a capacidade 

máxima resistente das vigas, confirmando desta forma algo que tinha sido concluíso no âmbito 

do estudo desenvolvido por Kotynia e Cholostiakow (2015).  

O modo de rotura mais comum das vigas reforçadas com CFRP foi o destacamento dos 

laminados de CFRP em forma de T do betão de recobrimento da viga; O corte dos estribos 
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inferiores na zona da colocação dos laminados em T (1T-30 e 2T-30) não afetou a capacidade 

de carga máxima nem a deformabilidade da viga reforçada. 

De acordo com Kotynia e Cholostiakow (2015) e Rezazadeh et al. (2016) esta técnica poderá 

vir a ser uma excelente alternativa no que respeita as técnicas de reforço estrutural à flexão com 

laminados de CFRP. 

                            

 

 

a. Vigas reforçadas com laminados de CFRP em forma 

de T aplicados com a técnica NSM (unidades em mm) 

b. Detalhe dos laminados de CFRP 

em forma de T 
 

Figura 2.9 - Reforço de vigas de betão armado à flexão usando a técnica NSM com laminados de 

CFRP em forma de T. 

A investigação sobre o comportamento de estruturas de betão armado reforçadas com CFRP 

usando a técnica NSM quando sujeitas a elevadas temperaturas é ainda reduzida, apesar de ser 

crucial importância. Segundo Barnes e Fidell (2006), a temperatura de transição vítrea do 

adesivo de ligação betão/CFRP é de 50 a 60 graus Celcius, o que indica que na presença de 

altas temperaturas associadas por exemplo a um incêndio, rapidamente estes valores são 

alcançados pondo em causa a ligação betão/CFRP. Baolin Yu e Venkatesh Kodur (2014) 

avaliaram o efeito da temperatura nas propriedades de resistência e rigidez de CFRP aplicados 

com técnica NSM. Foram testados 13 laminados e 12 varões de CFRP à tração uniaxial em 

ambiente de elevadas temperaturas. Estes ensaios visaram também o estudo da resina epoxy 

utilizada na técnica NSM como material de colagem (Figura 2.10), com o intuito de se saber o 

efeito das temperaturas nesta, isto é, de verificar as alterações das características mecânicas da 

resina epoxy ao longo do aumento progressivo da temperatura. Com estes ensaios foi possível 

concluir que a resina fica intacta até aos 200ºC, enquanto que os laminados de CFRP já 

apresentam cerca de 80% da resistência a tração inicial. Aproximadamente aos 305ºC foi 

atingida a temperatura crítica na qual os laminados perdem aproximadamente 50% da sua 

capacidade resistente à tração (Figura 2.11). 
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Figura 2.10 - Ensaio de tração uniaxial a elevadas temperaturas em laminados embebidos em resina 

epoxy. 

 

Figura 2.11 - Temperatura vs. força resistente do laminado de CFRP (adaptado Baolin Yu e Venkatesh 

Kodur, 2014). 

Entre os 300ºC e os 400ºC, a resina polimérica começou a decompor-se. Dos 400ºC até aos 

600ºC, apenas as fibras individuais contribuem para a carga resistente do laminado, atingindo 

os 10% da resistência à tração inicial, começando as fibras de carbono a oxidar. A partir dos 

400ºC já não existe qualquer resina epoxy na estrutura, visto que esta evaporou por completo, 

como se pode analisar na Figura 2.12. 

 

Figura 2.12 - Efeito da temperatura na resina epoxy utilizada na técnica NSM com CFRP (adaptado 

Baolin Yu e Venkatesh Kodur, 2014). 
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Neste estudo foram também testados e posteriormente comparados os laminados com os varões 

de CFRP. Observando a Figura 2.13, o comportamento dos laminados e dos varões de CFRP é 

muito semelhante, verificando-se que a temperatura crítica de ambos diferiu apenas 25ºC (a 

temperatura crítica dos laminados foi 305ºC e a dos varões foi 330ºC). Ambos os elementos de 

reforço de CFRP apresentaram uma relação linear entre a tensão e extensão em ambiente de 

elevadas temperaturas. No entanto, a extensão última destes perfis de CFRP decresce com o 

aumento da temperatura, o que é o oposto do que acontece num ambiente semelhante de 

elevadas temperaturas, de um reforço estrutural utilizando aço.  

 

Figura 2.13 - Comparação entre a relação temperatura vs. força resistente de laminados e varões de 

CFRP (adaptado Baolin Yu e Venkatesh Kodur, 2014). 

2.2.3 - Comparação entre as técnicas NSM e EBR 

Para que exista uma melhor perceção das limitações de cada técnica usada no reforço de 

estruturas de betão armado, serão descritas as principais vantagens da técnica NSM 

comparativamente com a técnica EBR: 

 A técnica NSM não requer qualquer tipo de preparação da superfície, apenas é necessário 

proceder à abertura dos entalhes no betão de recobrimento. Pelo facto do reforço estar 

inserido e não colado à superfície aumenta a probabilidade do betão que está em contacto 

com o laminado ser de melhor qualidade; 

 Menor risco de descolagem do reforço atendendo ao maior grau de fixação do reforço de 

CFRP. O laminado do reforço, usando a técnica NSM, tem o dobro da área de colagem 

comparativamente ao laminado da técnica EBR, o que faz com que o grau de fixação do 

laminado (NSM) aumente significativamente; 

 Facilidade na ancoragem dos CFRP aos elementos estruturais adjacentes (de forma a 

prevenir a ocorrência de roturas prematuras); 
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 Facilidade na aplicação de pré-esforço aos CFRP; 

 Menor exposição às ações mecânicas, desgaste e impacto; 

 Maior proteção ao fogo (maior resistência a elevadas temperaturas); 

 Maior proteção a atos de vandalismo; 

 Esteticamente, a estrutura reforçada não é afetada visualmente, quando tem os CFRP 

inseridos nos entalhes contrariamente ao que acontece com o reforço aplicado com a técnica 

EBR; 

 Solução de reforço mais adequada para reforçar estruturas de betão armado em termos de 

momentos negativos; 

Apesar das vantagens anteriormente mencionadas da técnica NSM em relação à técnica EBR, 

um aspeto importante que deve ser tido em consideração na utilização da técnica NSM está 

relacionado com a espessura do betão de recobrimento, visto que aos entalhes destinados à 

inserção dos laminados de CFRP podem estar associadas profundidades que podem colidir com 

o posicionamento das armaduras existentes na estrutura a reforçar. 

A investigação experimental realizada até ao presente tem vindo a demonstrar a melhor eficácia 

da técnica NSM em relação à técnica EBR. Neste contexto, refira-se o estudo realizado por 

Bilotta et al. (2015) no qual foram ensaiadas 10 vigas de betão armado (duas vigas de referência 

sem reforço, 4 vigas reforçadas utilizando a técnica EBR e 4 vigas reforçadas utilizando a 

técnica NSM), com 160mm de altura, 120 mm de largura e 2400mm de comprimento. 

Relativamente à armadura longitudinal, foram reforçadas com 2ϕ10 para a armadura de 

compressão e 2 ϕ10 para a armadura de tração. A armadura transversal era composta por ϕ6, 

espaçados de 200mm (Figura 2.14) 

 

Figura 2.14 - Vigas de betão armado reforçadas com CFRP ensaiadas à flexão por Bilotta et al. (2015). 

Nas vigas reforçadas com CFRP aplicando a técnica EBR, foram coladas chapas de 40mm de 

largura e 1.4 mm de altura na face tracionada das vigas (Figura 2.15ª). Nas quatro vigas 

reforçadas com CFRP, aplicando a técnica NSM, duas tinham 2 laminados (Figura 2.15b) e as 

outras duas tinham 3 laminados de CFRP (Figura 2.15c). Estes laminados com 10mm de altura 

e 1.4mm de largura foram inseridos em entalhes de 15mm de altura e 5mm de largura. 
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Figura 2.15 - Secção das vigas ensaiadas por Bilotta et al. (2015). 

Após o ensaio das vigas acima mencionadas, foram possíveis retirar as seguintes conclusões: 

 Os laminados de CRFP utilizados na técnica NSM são menos suscetíveis ao modo de rotura 

por destacamento dos CFRP do que utilizando a técnica EBR com as chapas de CFRP; 

 Os laminados de CFRP (quando são aplicados apenas 2 laminados) são menos eficazes no 

aumento da rigidez das vigas de betão armado do que as chapas utilizadas com a técnica 

EBR; 

2.3 - Comportamento de vigas de betão armado reforçadas com CFRP usando a técnica NSM 

Nesta seção é descrito o programa experimental realizado por Dias et al. (2012) com o objetivo 

de avaliar o comportamento de vigas de betão armado reforçadas à flexão com laminados de 

CFRP inseridos. No total foram ensaiadas 4 vigas, uma de referência sem CFRP e três 

reforçadas com percentagens diferentes de CFRP (reforço com um laminado, com dois 

laminados e com três laminados). As vigas apresentavam 2600mm de comprimento e secção 

transversal retangular de 150×300mm2. Foram utilizados para a armadura longitudinal de 

compressão dois varões de aço nervurado com 8mm de diâmetro (2ϕ8) e para a armadura 

longitudinal de tração dois varões de aço nervurado com 10mm de diâmetro (2ϕ10). Desta 

forma, as vigas continham uma percentagem de armadura longitudinal de tração de 0,38%. 

Relativamente aos estribos, foram colados estribos verticais (2ramos) com varões de aço 

nervurado de 6mm de diâmetro espaçados de 75mm (ϕ6//75). Na Figura 2.16 apresenta-se a 

geometria, o tipo de ensaio e as armaduras aplicadas às quatro vigas que foram ensaiadas.  

 

Figura 2.16 - Geometria, tipo de ensaio e armaduras de aço das quatro vigas ensaiadas, dimensões em 

milímetros (Dias et al., 2012). 
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As três vigas reforçadas com laminados de CFRP inseridos em entalhes efetuados no betão de 

recobrimento foram designadas por S1-M, S2-M e S3-M, sendo reforçadas com um laminado, 

dois laminados e três laminados, respetivamente, de acordo com o representado na Figura 2.17. 

Estes laminados apresentavam uma secção transversal de dimensões 1.4x10mm2 e tinham um 

comprimento de 2300mm. A extensão de rotura destes laminados foi estimada no valor de 18‰. 

 

Figura 2.17 - Secções transversais das vigas ensaiadas (adaptado de Dias et al., 2012). 

As vigas foram ensaiadas até à rotura com um carregamento monotónico. Na Figura 2.18 

apresenta-se a relação força vs. flecha a meio-vão das quatro vigas ensaiadas. 

Comparativamente com a viga de referência, as vigas reforçadas tinham maior rigidez, maior 

carga correspondente à cedência das armaduras e maior carga máxima. As vigas reforçadas com 

laminados de CFRP apresentam três fases principais de comportamento: 1) betão fendilhado; 

2) betão fendilhado com o aço não plastificado; 3) betão fendilhado após cedência do aço das 

armaduras longitudinais. Analisando a Figura 2.18, pode-se verificar também que, após a 

cedência das armaduras, o aumento da capacidade resistente das vigas reforçadas é 

aproximadamente linear, o que se deve ao comportamento linear elástico dos CFRP. Quanto 

maior a percentagem de CFRP, maior rigidez apresentaram as vigas após a cedência das 

armaduras.  

 

Figura 2.18 - Relação força-flecha a meio-vão das vigas ensaiadas (adaptado de Dias et al., 2012). 



22   Capítulo 2  

 

 

 

De acordo com os resultados dos ensaios, com o aumento do número de laminados inseridos, 

os acréscimos em termos de carga de início de fendilhação do betão (4 %, 10 % e 19% 

respetivamente, para as vigas reforçadas com 1, 2 e 3 laminados), carga correspondente à 

cedência das armaduras (10%, 23%, 34% respetivamente, para as vigas reforçadas com 1, 2 e 

3 laminados) e carga máxima resistente (42%, 80% e 103% respetivamente, para as vigas 

reforçadas com 1, 2 e 3 laminados) também aumentaram. A solução de reforço com três 

laminados (S3-M) permitiu a duplicação da carga máxima da viga de referência (103% 

superior) (Tabela 2.2). Dos vários acréscimos anteriormente referidos em termos de carga, foi 

o referente à carga máxima onde se verificaram maiores valores (Figura 2.19). 

Tabela 2.2 - Principais resultados experimentais obtidos por Dias et al. (2012). 

Viga Fcr (kN) ΔFcr (%) Fsy (kN) ΔFsy (%) Fmax (kN) ΔFmax (%) uFmax (mm) 

Referência 20.10 - 56.60 - 62.30 - 45.1 

S1-M 21.00 4 62.40 10 88.40 42 41.20 

S2-M 22.20 10 69.50 23 111.90 80 43.6 

S3-M 24.00 19 76.00 34 126.60 103 38.9 

 

Figura 2.19 - Efeito da percentagem de CFRP na eficácia da técnica NSM com laminados de CFRP 

aplicada no reforço à flexão de vigas de betão armado (adaptado Dias et al., 2012). 

Em termos de flecha a meio-vão, as vigas reforçadas com laminados tiveram uma flecha menor 

comparativamente a viga de referência (Ref-M). O valor da flecha a meio-vão referente à carga 

máxima das vigas reforçadas com laminados de CFRP, variou entre os 86% e 97% do valor da 

flecha a meio-vão associada à carga máxima da viga de referência. O modo de rotura da viga 

de referência foi por esmagamento do betão na zona comprimida após cedência das armaduras 

longitudinais. A viga reforçada apenas por um laminado de CFRP (S1-M) teve como modo de 

rotura o esgotamento da capacidade resistente à tração do CFRP, atingindo um valor para 

extensão máxima do laminado de CFRP de 17.9 ‰. Nas restantes vigas S2-M e S3-M, o modo 

de rotura registado foi o destacamento do CFRP do betão de recobrimento, sendo o valor da 
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extensão máxima registada para os laminados de CFRP de 17.4 ‰ e 14.9 ‰, respetivamente. 

Em termos médios, o valor da referida extensão máxima para as três vigas foi de 16,7 ‰, o que 

correspondeu a um grau de mobilização médio do reforço de 93%. Analisando estes valores, é 

possível concluir que o reforço de vigas de betão armado com CFRP, usando a técnica NSM 

tem um elevado nível de aproveitamento das capacidades resistentes dos CFRP.  

Este estudo será abordado novamente no âmbito do trabalho realizado nos capítulos 3 e 4 desta 

dissertação.
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Capítulo 3 
Modelação numérica de vigas de betão armado reforçadas 

à flexão com laminados de CFRP inseridos – GID/femix 

3.1 - Introdução  

A calibração de um modelo numérico a partir de resultados de ensaios experimentais efetuados 

(por exemplo: ensaios em vigas de betão armado reforçadas à flexão com laminados de CFRP 

aplicados com a técnica NSM), permite que, posteriormente, se possam efetuar estudos por 

intermédio de ensaios numéricos, obtendo resultados, para o exemplo anteriormente referido, 

como a relação força aplicada vs.  flecha a meio-vão, o padrão de fendilhação, deslocamentos, 

reações, extensões e tensões nos materiais, entre outros. Desta forma, tendo como base o 

comportamento experimental de um determinado conjunto de modelos, é possível, de uma 

forma mais rápida e económica, prever o comportamento de modelos semelhantes, variando 

um conjunto de parâmetros (estudos paramétricos) que não foram considerados na 

experimentação já realizada. Assim, numa primeira fase, é indispensável proceder à calibração 

do modelo numérico tendo como base os resultados obtidos em investigação experimental 

anteriormente realizada. Uma vez calibrado o modelo numérico, podem então ser feitos os 

referidos estudos paramétricos. O presente capítulo destina-se à descrição detalhada do 

faseamento da calibração do modelo numérico assim como a obtenção de resultados através 

dos softwares femix/posfemix e GID. Neste contexto foi efetuada a modelação numérica do 

comportamento das quatro vigas ensaiadas experimentalmente por Dias et al. (2012), que foram 

apresentadas no Capítulo 2 desta dissertação (viga REF, S1-M, S2-M e S3.M). Os softwares 

utilizados neste capítulo foram o prefemix, o femix, o posfemix e o GID. O programa prefemix 

lê um ficheiro de dados de extensão _gl.dat, verifica a informação nele contida e escreve os 

dados num ficheiro não formatado com uma extensão _gl.bin. O programa femix lê o ficheiro 

de extensão _gl.bin e calcula a estrutura. O programa posfemix tem como potencialidades o 

pós-processamento dos dados e resultados. O software GID inicialmente faz o “preenchimento” 

do ficheiro de dados de extensão _gl.dat, quando são introduzidas todas as características das 

vigas assim como da sua malha de elementos finitos, e, posteriormente, lê os resultados obtidos 

no pós-processamento efetuado pelo posfemix de forma gráfica e bastante intuitiva. A viga 

utilizada como exemplo para descrever o faseamento usado na modelação das vigas foi a viga 

de betão armado reforçada à flexão com um laminado de CFRP (viga S1-M) que se encontra 
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representada na Figura 3.1. Atendendo à simetria da estrutura em análise, na modelação das 

vigas foi apenas considerada metade da estrutura de acordo com o representado na Figura 3.2. 

 

Figura 3.1 - Geometria da viga S1-M testada por Dias et al. (2012) (dimensões em mm). 

 

Figura 3.2 - Esquema estrutural usado para a modelação das vigas. 

3.2 - Introdução dos dados referentes às vigas no software GID (regime linear) 

Para efetuar a introdução dos dados relativos aos elementos em estudo, é necessário introduzir-

se as coordenadas de x e y (Figura 3.3a e 3.3b), referentes aos vértices da geometria da viga, 

assim como os pontos de interceção das armaduras transversais com as armaduras longitudinais. 

Uma vez definidos os pontos principais da geometria da viga, irão ser criadas superfícies 

relativas ao betão e linhas relativas as armaduras (tópico 3.1.2). 

3.2.1 - Criação dos pontos principais da viga 

  

Geometry > Create > Point Utilities > Tools > Coordinates window 

Figura 3.3 - Criação de pontos por coordenadas. 

 

 

 

b a 
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3.2.2 - Criação das superfícies e linhas de cada material 

Em relação à criação das superfícies do betão, são selecionadas áreas compostas por quatro 

pontos (Figura 3.4b), de modo a criar uma superfície retangular, delimitada pelos 4 pontos 

selecionados. Na Figura 3.4a pode-se observar a localização no software GID do comando para 

a realização desta tarefa (Geometry > Create > NURBS Surface > By Points). É de referir que não 

é necessário criar linhas referentes à geometria do betão, pois estas serão criadas 

automaticamente com as superfícies. Assim, apenas é necessário criar as linhas referentes às 

armaduras longitudinais superior, inferior e transversal. No final de criar as superfícies deve-se 

clicar no lado direito do rato na tela branca e pressionar redraw.  

 

 

Geometry > Create > NURBS Surface > By Points 

Figura 3.4 - Criação da superfície através de pontos. 

Em função do que foi referido anteriormente, no que se refere às armaduras, deve-se ter o 

mesmo procedimento que para o betão, mas apenas se seleciona 2 pontos em simultâneo de 

forma a criar linhas que simulam a presença das armaduras longitudinais (superior e inferior) e 

das armaduras transversais. 

3.2.3 - Criação de layers para cada material 

Devem ser criados as layers (camadas) relativas a cada tipo de material utilizado, assim como 

se tem que distinguir as armaduras longitudinais superiores, das inferiores, uma vez que, 

geralmente, estas armaduras são diferentes. É necessário distinguir também as armaduras 

transversais da armadura transversal atravessada pelo eixo de simetria da viga. O modo de 

criação das layers está representado na Figura 3.5a. 

Deste modo, cada elemento da geometria desenhada no GID anteriormente, terá um layer 

associado, mediante o material que lhe está associado, como se pode ver na Figura 3.5b.  

b a 
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Layers > Create a new layer  Botão do lado direito na camada > Send to > Lines 

Figura 3.5 - Criação e associação dos layers aos elementos. 

Após atribuir a cada elemento geométrico desenhado da viga, o respetivo layer, deve-se 

verificar se estão bem atribuídos, clicando onde está representado o símbolo de uma “lâmpada” 

(Figura 3.5), que simboliza a ativação e desativação de cada layer. Desta forma, o utilizador 

poderá saber se atribuiu corretamente o layer certo, ao elemento certo. 

3.3 - Construção da malha de elementos finitos 

3.3.1 - Refinamento da malha de elementos finitos 

Para a definição da malha de elementos finitos a adotar, é necessário começar por definir o grau 

de refinamento da malha. No âmbito do presente estudo, foram analisados três níveis de 

refinamento para a simulação da viga de referência (viga REF): reduzido, intermédio e elevado, 

que se encontram representados, respetivamente nas Figuras 3.6a, 3.6b e 3.6c, com o objetivo 

de avaliar qual seria o melhor grau de refinamento da malha de elementos finitos, para trabalhos 

futuros na área da modelação numérica de vigas de betão armado. A malha com grau de 

refinamento reduzido é composta por 65 (5x13) elementos, a malha com grau de refinamento 

intermédio tem 182 (7x26) elementos e a malha com grau de refinamento elevado é composta 

por 728 (14x52) elementos.  

 

a. Grau de refinamento reduzido 

 

b a 
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b. Grau de refinamento intermédio 

 

c.  Grau de refinamento elevado 

Figura 3.6 - Graus de refinamento da malha de elementos finitos. 

Após efetuar os cálculos com o software femix (considerando modelo não linear definido de 

acordo com o descrito nas secções seguintes) foi possível obter a relação força vs. flecha a meio-

vão da viga em análise para os 3 níveis de refinamento e comparar com a relação força vs. 

flecha a meio-vão obtida experimentalmente. Concretamente, foram comparados os valores das 

forças obtidas numericamente para os três níveis de refinamento, com a força obtida 

experimentalmente, para os mesmos deslocamentos a meio-vão. Desta forma, foi possível 

calcular o erro entre os valores numéricos e os valores experimentais. O cálculo do erro para 

cada instante da curva de comportamento da viga analisada foi determinado por intermédio da 

seguinte expressão: 

Abs[Força Num - Força Exp) / Força Exp x 100]= Erro (%)                    (3.1) 

Em que: 

 Força Num é o valor da força obtida no modelo numérico, em correspondência com um 

determinado deslocamento estipulado; 

 Força Exp é o valor da força obtida experimentalmente para o mesmo deslocamento 

estipulado para a determinação de Força Num; 

 Abs função para se obter o valor absoluto do erro, isto é, a percentagem de erro obtida será 

sempre positiva. 

Como se pode observar na Tabela 3.1, utilizando o comando procv do software Excel, foi 

possível para cada deslocamento saber imediatamente o erro ocorrido para cada malha, uma 
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vez que esta função procura na lista de cada grau de refinamento a força respetiva ao 

deslocamento pretendido. 

Tabela 3.1- Exemplo da força e do respetivo erro para o deslocamento de 10mm. 

Grau de refinamento da malha Força Num (kN) Força Exp (kN) Erro (%) 

Reduzido 54.09 55.58 2.67 

Intermédio 55.76 55.58 0.34 

Elevado 57.62 55.58 3.68 

Na Tabela 3.2. apresenta-se, para cada grau de refinamento da malha analisado, a média dos 

erros a diferentes fases da relação força vs. flecha a meio-vão, nomeadamente a fase elástica 

(até ao início de fendilhação do betão), a fase entre o início de fendilhação do betão e a cedência 

das armaduras e a fase da pós cedência das armaduras. Para uma análise mais global dos 

resultados foi também calculada a média do erro, para cada tipo de malha em estudo, referente 

às 3 fases em simultâneo (Tabela 3.3). 

Tabela 3.2 - Erro médio das malhas analisadas (%) para cada uma das fases de comportamento da 

viga. 

Fase de comportamento da viga 
Grau de refinamento da malha 

Reduzido Intermédio Elevado 

Elástica 2.25 1.11 4.89 

Fendilhação do betão/cedência das armaduras 1.67 2.67 6.37 

Pós cedência das armaduras 3.10 1.07 1.38 

Tabela 3.3 - Erro médio das malhas analisadas (%) considerando todas as fases de comportamento da 

viga. 

Grau de refinamento da malha Reduzido Intermédio Elevado 

Erro médio 2.75 1.42 2.59 

A análise das Tabelas 3.2 e 3.3 permite que sejam retiradas as seguintes conclusões: 

 A malha com grau de refinamento reduzido tem a menor percentagem de erro na fase de 

fendilhação do betão/cedência das armaduras (1.67%), comparativamente com as outras 

duas malhas; 

 A malha com grau de refinamento intermédio tem a percentagem de erro mais reduzida na 

fase elástica (1,11 %) e na fase pós cedência das armaduras (1.07%,), comparativamente 

com as outras duas malhas. 
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 A malha que tem o menor erro médio, durante as três fases analisadas, é a malha com grau 

de refinamento intermédio, com 1.42%.  

 As três malhas em estudo obtiveram um erro médio, para as três fases de comportamento da 

viga analisadas, que variou entre 1.42% e 2.75%, o que indica que o refinamento da malha 

não altera significativamente a resposta numérica do modelo da viga em análise. 

A análise anteriormente efetuada (Tabelas 3.2 e 3.3) demonstra que, não é diretamente 

relacionável que uma malha mais refinada tenha associado menores erros, nem que uma malha 

menos refinada tenha associado maiores erros. Tal como representado na Tabela 3.2, a análise 

deve ser feita por fases, para que se possa ter uma melhor perceção das limitações de cada 

malha. 

Outro fator que foi contabilizado neste estudo sobre o nível de refinamento da malha, foi o 

tempo que demorou o cálculo de cada malha no software femix. Na Tabela 3.4 apresenta-se o 

tempo de cálculo no femix da estrutura modelada, com um grau de refinamento reduzido, 

intermédio e elevado. 

Tabela 3.4 - Tempo de cálculo do femix para cada nível de refinamento da malha. 

Grau de refinamento da malha Reduzido Intermédio Elevado 

Tempo de cálculo no femix 1min38seg 8min33seg 2h30min02seg 

A análise da Tabela 3.4 permite concluir que: 

 A malha de elementos finitos com menor tempo de cálculo foi a malha com um grau de 

refinamento reduzido (1 minuto e 38 segundos); 

 A malha com um grau de refinamento intermédio demorou 5.2 vezes mais que a malha com 

um grau de refinamento reduzido; 

 A malha com um grau de refinamento elevado demorou 17.5 vezes mais que a malha com 

um grau de refinamento intermédio e 91.9 vezes mais que malha com um grau de 

refinamento reduzido. 

O número de elementos finitos que uma malha deve ter, pode ser relacionável, numa primeira 

fase, com a geometria da face lateral da viga que se pretende estudar. Com os diferentes níveis 

de refinamento adotados (reduzido, intermédio e elevado), foi possível concluir que a malha 

com um grau de refinamento intermédio obteve resultados mais eficazes, comparativamente 

com as outras malhas. O número de elementos finitos por cada decímetro quadrado da face 

lateral da viga a utilizar poderá ser uma boa estimativa para se saber que tipo de malha utilizar, 

tendo como objetivo otimizar simultaneamente o desempenho em termos do tempo de cálculo 
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no femix e do nível de erro entre o modelo numérico e o experimental. Uma vez que a área 

lateral de meia viga era de 39 dm2 (13×3dm), é possível verificar, de acordo com os dados da 

Tabela 3.5, que o número de elementos finitos que uma malha deve ter para ser de grau de 

refinamento intermédio deverá ser igual a aproximadamente 5 vezes o valor da área da face 

lateral da viga quantificada em decímetros quadrados (Expressão 3.2 em que e é o número de 

elementos finitos da malha, A é a área da face lateral e n é o número de elementos por dm2). 

Uma vez que se obtém o número de elementos finitos da malha (e), apenas é necessário 

conhecer por quantos elementos se deve dividir o comprimento e a altura da viga. A relação do 

número de elementos finitos para a altura e o comprimento de meia viga, para um grau de 

refinamento intermédio, deve ser aproximadamente 1:4. Por exemplo: se se obtém um número 

de elementos finitos para a malha de uma viga (e) igual a 100, deve-se colocar 5 elementos 

finitos para a altura e 20 para o comprimento, cumprindo assim a razão de 1:4, assim como os 

100 elementos previamente calculados (Figura 3.7). 

 

Figura 3.7 - Relação entre o número de elementos finitos da altura e o número de elementos finitos do 

comprimento da viga para um grau de refinamento intermédio (1:4).  

Com este estudo, o conceito de um grau refinamento intermédio pode ser aplicado a todo o tipo 

de dimensões de vigas. 

𝑛 =
𝑒

𝐴
                                                    (3.2) 

Tabela 3.5 -  Número de elementos por dm3 de cada malha. 

Grau de refinamento da malha Reduzido Intermédio  Elevado 

Número de elementos finitos da malha (e) 65 182 728 

Número de elementos finitos por dm2 (n) 1.7 4.7 18.7 

3.3.2 - Construção da malha de elementos finitos 

Antes de proceder à construção da malha de elementos finitos é necessário definir o tipo de 

elemento finito que se pretende, isto é, o número de pontos de integração que constituem cada 
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elemento finito. Este tópico é selecionado no GID, como se pode observar na Figura 3.8. Na 

presente dissertação foram utilizados elementos finitos bidimensionais de 8 nós para o betão e 

elementos finitos unidimensionais de 3 nós para as armaduras e para o CFRP (estes tipos de 

elementos são associados à malha por intermédio da função Quadratic). Caso se pretenda 

escolher elementos mais simples, pode-se optar por selecionar a função Normal à qual estão 

associados elementos finitos bidimensionais de 4 nós (para o caso do betão) e elementos finitos 

unidimensionais de 2 nós (para o caso das armaduras e do CFRP). 

 

Mesh > Quadratic type> Quadratic 

Figura 3.8 - Seleção do número de pontos de integração dos elementos. 

No âmbito da construção da malha de elementos finitos, existem duas hipóteses (Figura 3.9) 

que podem ser utilizadas: Assign number of cells (atribuir nº de células) e/ou Assign size 

(atribuir tamanho das células). 

.  

Mesh > Stuctured > Surfaces/Lines > Assign number of cells e/ou Assign size 

Figura 3.9 - Construção da malha de elementos finitos. 

Caso seja escolhido Assign number of cells, o elemento pretendido irá ser dividido no número 

de células que for introduzido. Caso seja escolhido Assign size, o elemento pretendido será 
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divido em células com o tamanho introduzido, previamente, em milímetros. Para se proceder à 

construção da malha utilizando a função Assign size deve-se, em primeiro lugar, selecionar a 

superfície, caso seja o betão, ou linha, caso seja CFRP ou armaduras. De seguida é necessário 

pressionar ESC e introduzir o valor da dimensão lateral de um elemento finito da malha (em 

milímetros). Posteriormente, pressiona-se Assign e seleciona-se o elemento a que se pretende 

atribuir a dimensão escolhida (fazendo o mesmo processo para a segunda dimensão de cada 

elemento). A tarefa termina pressionando ESC outra vez. O procedimento para a opção Assign 

number of cells, é igual ao descrito para a função Assign size, com a excepção do valor a ser 

introduzido, pois neste caso será referente ao número de células que dividirá o elemento 

selecionado. Assim, no caso de superfícies (exemplo do betão no presente estudo) utiliza-se 

Mesh > Structured > Surfaces > Assign size ou Assign number of cells e no caso das linhas 

(para o as armaduras de aço e para os CFRP no presente estudo utilizou-se Mesh > Structured 

> Lines > Assign size ou Assign number of cell. Por forma a que não exista conflito de layers, 

deve-se ocultar o layer do betão quando se cria a malha para as armaduras, assim como se deve 

ocultar as layers do aço e do CFRP quando se cria a malha para o betão. No âmbito do presente 

trabalho, foi utilizado para o betão o comando Assign size para ambas as direções do elemento, 

enquanto que para os CFRP e as armaduras, foi utilizado o comando Assign number of cells.  

Uma vez que, quer a superfície de betão, como as linhas correspondentes às armaduras e ao 

CFRP foram divididas em elementos finitos, pode-se nesta fase gerar a malha (Generate mesh) 

e posteriormente colapsar a malha (Colapse mesh), tal como se pode observar na Figura 3.10. 

  

Mesh > Generate mesh Mesh > Edit mesh > Colapse > Mesh 

Figura 3.10 - Criação da malha de elementos finitos. 

A necessidade de colapsar a malha, é devido ao facto de no local onde estão os nós dos 

elementos finitos referentes às armaduras, existirem já os nós referentes aos elementos finitos 

do betão (sobreposição de nós). Desta forma deve-se sempre colapsar a malha no final de a 

gerar, de modo a eliminar todos os pontos sobrepostos. Uma vez colapsada a malha de 

b a 
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elementos finitos, pode-se introduzir a informação referente às características dos materiais, 

dos apoios, das cargas/deslocamentos prescritos nela aplicados e as combinações existentes 

(Figura 3.11).  

 

Figura 3.11 - Malha de elementos finitos construída. 

3.4 - Atribuição das características respetivas aos elementos da malha 

3.4.1 - Tipo de problema (Problem type) 

Antes de atribuir as características dos elementos da malha de elementos finitos é necessário 

escolher qual o software que se pretende para efetuar os cálculos da estrutura que foi introduzida 

no GID. No âmbito da presenta dissertação, o software escolhido foi o femix. Quando o GID é 

instalado no computador, este não tem por defeito o femix na sua base de dados relativos aos 

softwares de cálculo. Para tal, é necessário obter uma pasta que foi denominada por femix.gid 

(contém ficheiros executáveis do femix) e, posteriormente, deve ser colada na diretoria 

C:\Program Files\GID\GID 11.1.9d\problemtypes. De seguida, abre-se o GID e como se pode 

verificar na Figura 3.12, o software femix já aparece na lista de softwares possíveis para o 

cálculo da estrutura. Para terminar o processo de escolha do software de cálculo, deve ser 

selecionado femix. 

 

Data > Problem Type > femix 

Figura 3.12 - Tipo de software de cálculo a utilizar com software GID. 

3.4.2 - Condições (Conditions) 

Nesta fase é definido o tipo de elemento finito a usar e suas características, os apoios da 

estrutura e as cargas/deslocamentos prescritos a que a estrutura está sujeita. Além disso, serão 
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ainda introduzidas as características dos materiais utilizados e as combinações a iterar 

posteriormente no femix. 

3.4.2.1 - Propriedade dos elementos (Element Properties) 

No que se refere às propriedades dos elementos (Element Properties), apresentada na Figura 

3.13a, no presente estudo foram utilizados dois tipos de elementos (element type): Plane stress 

quad e Emb cable 2D. O Plane stress quad foi utilizado para os elementos de betão, no qual é 

apenas necessário introduzir a espessura (thickness) da viga em milímetros, que no âmbito do 

estudo desta dissertação, era de 150mm (Figura 3.13b). O Emb cable 2D foi utilizado para as 

armaduras e para o CFRP, sendo necessário introduzir a área total das secções do elemento. Por 

exemplo em termos de armaduras longitudinais inferiores, as vigas ensaiadas por Dias et al. 

(2012) que foram usadas neste estudo tinha 2ϕ10, o que corresponde a uma área total de 

157.08mm2 (Figura 3.13c). Após inserir o valor da área de armadura, deve-se premir Assign e 

selecionar o layer pretendido. No final de introduzir todos os valores de todos os layers, deve-

se verificar sempre se todos os elementos têm as suas propriedades atribuídas, pressionando 

dentro dos element properties, draw>Colors. Obtendo-se uma figura semelhante à Figura 3.14. 

 

  

 
 

Data>Conditions> Element Properties 

Figura 3.13 - Introdução das propriedades dos elementos da malha. 

         

Data>Conditions> Element Properties>draw>Colors 

Figura 3.14 - Visualização gráfica das propriedades dos elementos. 

a b c 



Modelação numérica – GID/femix 37 

 

 

 

3.4.2.2 - Cargas (Loads) 

A forma de proceder à introdução das cargas ou dos deslocamentos prescritos atuantes na 

estrutura está ilustrada na Figura 3.15. No âmbito do estudo da presente dissertação, foi 

adicionada na estrutura uma carga pontual de -500N na direção de y (Figura 3.15b). Para atribuir 

uma carga ou um deslocamento a um nó da malha de elementos finitos, deve-se introduzir o 

respetivo valor na direção pretendida, selecionar Assign, selecionar o nó da malha de elementos 

finitos pretendido e pressionar ESC. Para verificar se a carga ou o deslocamento foram bem 

atribuídos deve-se pressionar na mesma janela a sequência draw>colors.  

 

  

Data > Conditions > Loads 

Figura 3.15 - Introdução das cargas e deslocamentos prescritos. 

3.4.2.3 - Apoios (Supports) 

Nesta fase procede-se à simulação de todos os apoios existentes na estrutura. Para a introdução 

dos apoios é necessário selecionar qual a direção ou direções em que se pretende bloquear o 

movimento. Posteriormente prime-se Assign e seleciona-se o nó da malha de elementos finitos 

onde se localiza o apoio que se pretende simular. Para visualizar o conjunto de apoios 

introduzidos na malha, pressiona-se dentro da janela dos apoios, draw > All Supports (Figura 

3.16c.). Como já foi referido no início deste capítulo, na presente dissertação é apenas calculada 

meia estrutura, devido à simetria estrutural existente (Figura 3.1 e 3.2). Assim, no eixo de 

simetria da estrutura, são considerados em todos os nós apoios de roletes (com o deslocamento 

em x e z bloqueados). O apoio duplo existente na estrutura foi simulado, bloqueando o 

deslocamento na direção de x e y (Figura 3.16b). 

a b c
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Data > Conditions > Supports 

Figura 3.16 - Introdução dos apoios da estrutura. 

3.4.3 - Materiais (Materials)  

A forma de introdução dos parâmetros referentes à caracterização dos materiais a usar no 

modelo numérico é apresentada nesta secção. Os materiais dos modelos de vigas usados na 

presente dissertação são o betão, o aço e o CFRP (Figura 3.17). 

 
 

Data > Materials > Continuos Materials 

Figura 3.17 - Introdução dos materiais. 

Uma vez que, numa primeira fase deste estudo, se efetuou uma análise da estrutura 

considerando um comportamento linear, deve-se selecionar LIN ISO Concrete para adicionar 

os parâmetros do betão, LIN ISO Steel para adicionar os parâmetros do aço, tal como se pode 

observar na Figura 3.16b. Em relação ao CFRP, para simular o seu comportamento linear deve-

se criar um material novo replicando os parâmetros do LIN ISSO Steel. Seja para o betão, para 

o aço ou para o CFRP, os parâmetros que serão pedidos são a massa volúmica (ρ), o coeficiente 

de dilatância térmica (α), o módulo de elasticidade (E) e o coeficiente de Poisson (ʋ), tal como 

representados na Figura 3.17. As unidades que se devem utilizar são de Newton (N) e 

milímetros (mm). Assim, para a massa volúmica o valor deve ser introduzido em N/mm3, para 

o coeficiente de dilatância térmica deve ser introduzido o valor em °C−1 enquanto que para o 

módulo de elasticidade, o valor deve ser introduzido em N/mm2. O coeficiente de Poisson é 

adimensional. 

a b c 

b a 
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Figura 3.18 - Parâmetros do betão considerando comportamento linear material. 

Após a introdução das propriedades dos materiais utilizados, o passo seguinte é atribuir os 

materiais aos respetivos elementos. Para que seja mais fácil realizar esta tarefa é aconselhável 

ativar apenas os layers que são necessários, de modo a que não existam erros posteriores e seja 

mais simples e clara a visualização do elemento pretendido.  

Como se pode observar na Figura 3.19b, para o elemento de betão, com apenas o layer Concrete 

(betão) ativo, pressiona-se Assign > Elements (Figura 3.19a), seleciona-se todo o elemento de 

betão e prime-se ESC. Para o aço e para o CFRP efetua-se o mesmo processo. No final da 

atribuição dos materiais aos elementos respetivos, para que seja possível visualizar todos os 

materiais atribuídos na malha (Figura 3.20), é necessário efetuar a seguinte sequência: Data > 

Materials > Continuos Materials > Draw > all materials. A legenda da Figura 3.20 refere-se 

ao tipo de materiais que foram atribuídos aos elementos da viga S1-M, isto é: 

 LIN ISO Concrete: betão com comportamento linear; 

 LIN ISO Steel 6, 8 e 10: aço das armaduras com comportamento linear referente a varões 

com 6, 8 e 10 mm de diâmetro, respetivamente; 

 CFRP: CFRP com comportamento linear. 

 

 
 

Figura 3.19 - Atribuição de um material ao respetivo elemento. 

 

b a 
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Figura 3.20 - Render da malha de elementos finitos com os respetivos materiais atribuídos. 

3.4.4 - Casos de carga (Interval Data) 

A etapa seguinte diz respeito à definição de casos de carga, de acordo com o representado na 

Figura 3.21a. Para tal, é necessário apenas definir o nome da carga a aplicar (Load title) e 

indicar se é pretendido a aplicação da correspondente ação da gravidade (Figura 3.21b). Para 

os restantes tópicos, podem ser utilizados os que estão por defeito do software GID. No final 

é necessário premir “Accept”. 

  

Data > Interval Data 

Figura 3.21 - Introdução do caso de carga. 

3.4.5 - Combinações (Combinations) 

Por forma a introduzir as combinações do modelo numérico com comportamento linear, numa 

primeira fase, deve-se pressionar Data > Combinations (Figura 3.22a), abrindo-se uma janela 

de acordo com o representado na  Figura 3.22b. De seguida, é necessário dar um nome à 

combinação (Combinations title). Posteriomente, aconselha-se a colocação do valor de “1” no 

número de incrementos de combinações (Number of Increment in the Combination) e a 

selecionar o número de casos de carga estipulado anteriormente (Number of Load Cases). 

Relativamente ao factor de carga (load factor) é aoncelhável a utilização de “1”. Para adicionar 

esta combinação, deve-se pressionar “Add”. Para concluir a operação, é necessário premir 

“Accept”.  

b a 
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Data > Combinations 

Figura 3.22 - Introdução das combinações. 

Esta combinação foi criada apenas para que sejam corridos os software prefemix e o femix, com 

o objetivo de se verificar se não existem erros a nivel de malha e propriedades dos elementos.  

Após percorridas todas as etapas descritas em 3.2, 3.3 e 3.4 deste capítulo, é possível proceder 

ao cálculo da estrutura em comportamento linear usando o prefemix e o femix (secção 3.5). 

3.5 - Verificação do modelo numérico em regime linear no femix 

Antes de prosseguir para a transformação do modelo numérico de regime linear para regime 

não linear, convém fazer sempre a verificação do modelo numérico em regime linear, utilizando 

os softwares prefemix e femix (Figura 3.23a). Para tal, apenas é necessário correr o modelo no 

software e aguardar que a única combinação introduzida seja feita calculada com sucesso como 

se pode observar na Figura 3.23b.  

 

  

Figura 3.23 - Mensagem de sucesso após calculo no femix. 

Após aparecer a mensagem ### Success ### (Figura 3.23b) fecham-se as duas janelas cmd.exe 

referentes ao femix e passa-se para a etapa seguinte, que tem como objetivo transformar o 

modelo numérico atual com comportamento linear material, num modelo numérico de 

comportamento não linear material. 

 

b a 

b a 
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3.6 - Transformação do modelo numérico de regime linear para regime não linear 

Para que se possa alterar um modelo numérico de regime linear para um regime não linear, 

deve-se realizar três alterações específicas ao modelo existente, nomeadamente: alteração dos 

parâmetros principais (Main Parameters), alteração das características dos materiais utilizados 

(Continuos Materials > NLMM) e alteração das combinações (Combinations). 

3.6.1 - Alteração dos parâmetros principais (Main Parameters) 

Em relação à alteração dos parâmetros principais, tal como se pode observar na Figura 3.24, 

deve-se colocar apenas um visto no quadrado correspondente a “Materially Nonlinear 

Problem” (Problema materialmente não linear) e de seguida pressionar “Accept”. 

                                Data > Main Parameters > 

Figura 3.24 - Alteração dos parâmetros principais. 

3.6.2 - Alteração das características dos materiais utilizados  

Nesta fase deve ser feita a alteração das características dos materiais utilizados: betão, aço, 

CFRP. Assim, no caso do betão em vez de ser escolhido “LIN ISO Concrete” deverá ser 

escolhido o “NLMM104 Concrete”. Para o aço, em vez de ser escolhido o “LIN ISO Steel” 

deverá ser escolhido o “NLMM201 Steel”. Neste contexto, deverá ser considerada que existem 

diferentes tipos de aço associados aos três tipos de varões existentes nas vigas em análise 

(varões de aço com diâmetro de 6, 8 e 10mm). Assim, de acordo com a Figura 3.24b para o aço 

dos varões com 6, 8 e 10mm foi considerado, respetivamente, NLMM201 Steel6, NLMM201 

Steel8 e NLMM201 Steel10. 

 

 

Figura 3.25 - Alteração das características dos materiais utilizados. 

 

b a 
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Na Figura 3.26 é possível verificar os parâmetros necessários para a simulação do 

comportamento do betão referente ao modelo escolhido (NLMM104 Concrete). Na Figura 3.26a 

pode-se observar a janela das propriedades genéricas (Generic Properties) e verificar que o 

único valor que não foi considerado, quando se introduziu o betão como tendo comportamento 

linear, foi o da tensão fc (resistência à compressão do betão expressa em MPa). Na Figura 3.26b 

estão representadas as propriedades de fratura modo I (Fracture Mode I Properties) que tem 

direta correspondência com o diagrama Tensile-Softening (que tem como tradução para a língua 

portuguesa diagrama de amolecimento de tração do betão) apresentado na Figura 3.27. Assim, 

para o estudo a realizar no âmbito da presente dissertação foi escolhido o diagrama do tipo 

trilinear. 

 

  

Figura 3.26 - Parâmetros do betão em comportamento não linear material. 

 

Figura 3.27 - Diagrama de amolecimento em tração do betão (tensile-softening). 

Os parâmetros que são necessários preencher, para o quadro da Figura 3.26b, são os seguintes: 

 fct: resistência à tração do betão (MPa);  

 ξ1, ξ2: razão entre a extensão correspondente à tensão pós-pico 1 (1fct) e pós-pico 2 (2fct), 

respetivamente, e a extensão última do diagrama trilinear Tensile-Softening do betão (os 

valores adotados para ξ1 e ξ2 foram 1,0×10-2 e 2.0×10-1, respetivamente); 

b a 
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 α1, α2: razão entre a tensão pós-pico 1 e pós-pico 2, respetivamente, e a resistência à tração 

do betão (fct), tendo-se adotado 5.0×10-1 e 2.0×10-1, respetivamente, para α1 e α2. 

 GF´: Energia de Fratura (Modo I) - na presente dissertação foi utilizado do valor numérico 

de 0,085, tendo sido este calculado segundo o MC2010; 

 Parameter to the Model I Frature Energy avaiable to the new crack: Parâmetro de energia 

de fratura modo I disponível para abertura de nova fenda, tendo sido adotado o valor de 1. 

Para os restantes parâmetros (Fracture Mode II Properties; Miscellaneous; Out-of-Plane Shear 

(OP) Data) admitiram-se os valores por defeito para esta dissertação. No final da introdução 

dos parâmetros do betão, deve-se pressionar Update Changes para que os novos valores sejam 

guardados. 

Na Figura 3.28 apresentam-se os parâmetros necessários a preencher em termos da modelação 

do comportamento do aço (NLMM201 Steel). De acordo com a Figura 3.28a existem parâmetros 

que são idênticos aos introduzidos quando se simulou o aço com comportamento linear, 

nomeadamente a massa volúmica (ρ) e o coeficiente de dilatância térmica (α). Em relação aos 

restantes parâmetros foram utilizados neste estudo os valores resultantes dos ensaios 

experimentais efetuados para a caracterização do aço das vigas ensaiadas por Dias et al. (2012). 

Na Figura 3.28b (gráfico tensão vs. extensão) é possível ver o significado dos vários parâmetros 

necessários para o preenchimento do quadro da Figura 3.28a. em termos de extensões e tensões 

em determinadas fases do comportamento do aço. Em relação ao parâmetro Third Branch 

configuration (configuração do terceiro patamar da Figura 3.28b), o valor que foi considerado 

foi de 1, sendo este o valor por defeito do software GID.  

 

  

Figura 3.28 - Parâmetros do aço e do CFRP em comportamento não linear material. 

 

b a 
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Referente ao aço e ao CFRP, quanto às suas propriedades em comportamento não linear, 

observando a Figura 3.28a, denota-se que existem parâmetros que são idênticos aos 

introduzidos para comportamento linear, nomeadamente a massa volúmica (ρ) e o coeficiente 

de temperatura (α). Para completar os restantes parâmetros, foram utilizados nesta dissertação, 

os valores adquiridos pelos ensaios efetuados em laboratório, através de gráficos semelhantes 

ao da Figura 3.28b, que demonstram o comportamento do aço sujeito a esforços de tração. 

 εsy: Extensão final de regime elástico; 

 εsh: Extensão final de regime elasto-plástico; 

 εsu: Extensão total relativa à tensão máxima de rotura; 

 fsy, fsh: Tensão de cedência; 

 fsu: Tensão máxima de rotura; 

 Third Branch configuration: Configuração do terceiro setor do diagrama; foi utilizado nesta 

dissertação o valor por defeito do software GID igual a 1,0. 

 

O CFRP é um material com comportamento linear elástico até à rotura. Para que o modelo 

numérico funcione corretamente é necessário existir um critério de paragem associado ao CFRP 

(introdução da sua extensão de rotura e a respetiva tensão máxima). O valor da tensão e a 

extensão de rotura dos laminados utilizados no reforço das vigas em análise (Dias et al., 2012) 

era de 3165 MPa e 0.018, respetivamente. Para se poder simular o CFRP com comportamento 

similar ao do aço (Figura 3.28b), deve-se considerar os três ramos com a mesma inclinação 

dada pelo módulo de elasticidade do CFRP. O resultado da comparação da relação força vs. 

flecha a meio-vão numérica e experimental está representado na Figura 3.29.   

 

Figura 3.29 - Relação Força vs. flecha a meio-vão da viga S1-M considerando uma extensão de 

rotura igual a 0.018. 
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Este resultado em termos numéricos (rotura aos 32mm) indica que durante o carregamento da 

viga ocorreu algum deslizamento do laminado previamente à sua rotura. Para se conseguir 

maior proximidade entre resultados numéricos e experimentais, em termos da relação força-

flecha a meio-vão, foi necessário criar uma compensação no comportamento dos laminados, 

com uma diminuição sucessiva do seu módulo de elasticidade ao longo das três fases do 

diagrama tensão vs. extensão, aumentando assim a extensão de rotura. Para que o modelo 

numérico efetuado simule um comportamento semelhante ao comportamento da viga a nível 

experimental, foi necessário recriar um comportamento não linear para o CFRP, com 3 pontos, 

como se pode observar a Tabela 3.6. (3 extensões e respetivas tensões) para o CFRP.  

Tabela 3.6. Dados da relação tensão vs. extensão do CFRP. 

Extensão (‰) Tensão (MPa) E (GPa) 

0 0 0 

0.012057 2110 175.0 

0.016984 2632.5 155.0 

0.02532 3165 125.0 

O comportamento do laminado de CFRP está representado na Figura 3.30. Nesta figura podem-

se observar as três fases do diagrama tensão vs. extensão, assim como o decréscimo do declive 

de cada tramo, associado ao decréscimo do módulo de elasticidade. 

 

Figura 3.30 - Gráfico Tensão-Extensão do CFRP para os modelos numérico. 
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Desta forma, obteve-se um resultado numérico bem mais realista, como se pode observar na 

Figura 3.31: 

 

Figura 3.31 - Relação Força vs. flecha a meio-vão da viga S1-M (com simulação de deslizamento 

do CFRP). 

3.6.3 - Alteração das combinações  

 
 

Figura 3.32 - Alteração das combinações. 

3.6.3.1 - Alteração convencional das combinações 

Para transformar o modelo numérico de regime linear para regime não linear é necessário alterar 

a combinação utilizada anteriormente (Figura 3.32a). Os parâmetros que deverão ser alterados 

são (Figura 3.32b): 

 Número de incrementos na combinação (Number of Increments in the Combination): este 

valor representa o número de incrementos que irão ser calculados no femix por cada 

combinação, isto é, se o valor do número de incrementos for 100 e o fator de carga for 50, 

cada incremento terá 0,5 e será repetido 100 vezes nessa combinação; 

 Fator de carga (Load Factor): este valor definirá o valor dos incrementos anteriormente 

descritos, sendo que quanto maior for o fator de carga, maior será o valor de cada incremento.  
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3.6.3.2 - Arc length 

Na altura em que se efetua a alteração das combinações para transformar o modelo de 

comportamento linear num modelo de comportamento não linear, foi selecionada a opção para 

utilização da ferramenta do arc length. Esta ferramenta tem o objetivo de melhorar as 

simulações numéricas efetuadas no software femix, tendo como foco a possibilidade de cálculo 

com precisão mesmo quando ocorrem fenómenos de snap-back ou snap-through, como 

ilustrado na Figura 3.33. 

 

Figura 3.33 - Fenómenos de snap-through e snap-back (Gouveia et al., 2006). 

O procedimento necessário para utilizar a ferramenta do arc length, assim como a descrição de 

cada parâmetro a preencher, estão apresentados por ordem de preenchimento, imediatamente 

após a Figura 3.34. 

  

Data > Main Parameters > Nonlinear Analysis >Arc Length 

Figura 3.34 - Utilização da função arc length. 

 

b a 
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i. Iterative Algorithm 

Como se pode observar na Figura 3.34a, após selecionar a opção Arc Length deve-se escolher 

o algoritmo iterativo pretendido (Iterative Algorithm); na presente dissertação foi selecionado 

o Newton-Raphson Mode 1 visto ser o mais apropriado para o caso de estudo adotado.  

ii. Convergence Criterion 

De seguida deve-se escolher o critério de convergência (Convergence Criterion), existindo a 

possibilidade de ser pela norma do deslocamento (Displacement Norm), pela norma da força 

(Force Norm) ou pela energia (Energy); foi utilizado nesta dissertação o critério de 

convergência relativo à energia. 

iii. Tolerance in Each Combination 

A tolerância de cada combinação (Tolerance in Each Combination) utilizada nesta dissertação 

foi de 1.00×10-3. Este será o erro máximo admitido durante o cálculo das iterações. Uma vez 

que o erro é menor que a tolerância estipulada, a combinação converge e passa à combinação 

seguinte. Caso numa determinada combinação, o erro das suas iterações não consiga baixar a 

tolerância introduzida pelo utilizador, geralmente ocorre o efeito Ping-Pong fazendo com que 

não haja convergência para a combinação em causa e seja necessário aumentar o Displacement 

Increment (ponto vi). 

O efeito Ping-Pong anteriormente mencionado refere-se à situação em que o erro de várias 

iterações de uma combinação, durante o cálculo do femix, não converge, aumentando e 

diminuindo o seu valor. Assim, não segue a sequência normal de convergência em que o erro 

vai diminuindo ao longo das iterações, para cada combinação, até um valor estipulado 

previamente (Tolerance in each combination), de forma a convergir e a transitar para a próxima 

combinação. 

iv. Maximum Number of Iteration in Each Combination 

Como se pode observar na Figura 3.34b., é necessário definir o número máximo de iterações 

de cada combinação (Maximum Number of Iteration in Each Combination) e 400 foi o valor 

estipulado no âmbito do estudo realizado na presente dissertação.  

v. Node Number 

A tradução de Node Number para a língua portuguesa é “número do nó” e, neste contexto, 

refere-se precisamente ao número do nó da malha de elementos finitos onde será aplicado o 

incremento de descolamento (Displacement Increment).  
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vi. Displacement Increment 

O incremento de deslocamento será o valor do deslocamento aplicado no Node Number, que na 

presente dissertação foi aplicado inicialmente um deslocamento de -1 na direção de y (Degree 

of Freedom = y).  

vii. Number of Combinations Before Restart 

Para que se compreenda melhor esta funcionalidade é necessário previamente explicar o 

conceito de Restart. Esta ferramenta, que traduzida para a língua portuguesa significa 

“recomeço”, tem como função reiniciar o cálculo do femix na combinação que se pretende. Por 

exemplo, se forem definidas 400 combinações e na combinação 290 aparece a mensagem de 

erro do femix na qual refere que a combinação não convergiu, devido ao erro das iterações 

efetuadas nessa combinação, não ser menor que a tolerância admitida para cada combinação, 

pode-se utilizar a ferramenta restart introduzindo o número de 289 (tem de ser sempre a última 

combinação que convergiu com sucesso), aumentando de seguida o incremento de 

deslocamento. Este procedimento repete-se o número de vezes necessárias até que todas as 

combinações convirjam. Na Tabela 3.7 pode-se observar todos os Restart utilizados no femix 

no âmbito das 4 vigas em estudo (REF. S1-M, S2-M e S3-M). 

viii. Maximum Number of Arc Length Combinations 

O número máximo de combinações do arc length será o número de combinações que irão ser 

calculadas para um determinado incremento de deslocamento. Por exemplo, se se colocar neste 

parâmetro o valor de 100 e o incremento de deslocamento for de -0.2, o modelo numérico irá 

calcular até um deslocamento total de 20 mm (100*0.2=20) num determinado nó escolhido pelo 

utilizador (Node Number). Utilizando a ferramenta restart: se o modelo convergir até à 90ª 

combinação com um incremento de -0.1 e na 91ª combinação já não converge, deve-se utilizar 

a função restart na combinação 90ª e aumentar o incremento para -0.15 até à 100ª. O 

deslocamento total no nó pretendido pelo utilizador será igual a 10.5mm (90×0.1+10×0.15). 
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Tabela 3.7 - Alteração dos incrementos para a função restart. 

Vigas Combinação (Restart) Incremento Flecha a meio-vão (mm) 

REF 0 - 450 -0.1 45 

 

S1-M 

0 - 315 -0.1  

41.4 
316 – 345 -0.15 

346 - 372 -0.20 

 

 

S2-M 

0 - 256 -0.1  

 

49.05 
257 – 261 -0.15 

262 – 265 -0.2 

266 – 331 -0.25 

332 – 351 -0.3 

 

 

S3-M 

0 – 208 -0.1  

52.75 
209 – 253 -0.15 

254 – 303 -0.2 

304 – 366 -0.25 

 

ix. Displacement Control e Arc Length Parameters 

Para estes parâmetros foram utilizados, nesta dissertação, os valores que estavam por defeito 

do femix. 

Após o utilizador preencher todos os parâmetros relativos à alteração do modelo numérico de 

comportamento linear para um modelo numérico de comportamento não linear material, 

seguindo a ordem anteriormente descrita, é necessário pressionar Accept para que sejam 

guardadas as alterações efetuadas. De seguida é possível executar o femix. Logo que surja a 

mensagem de sucesso de cálculo do femix, igual à referida no ponto 3.5 deste capítulo, é 

possível proceder ao tratamento dos resultados obtidos pelo femix utilizando as potencialidades 

dos softwares posfemix e GID. 

3.7 - Posfemix-GID 

Este tópico destina-se a descrever o processamento dos resultados obtidos após o cálculo 

efetuado anteriormente no femix, usando para tal o software posfemix. No final do cálculo 

efetuado pelo femix, tal como referido anteriormente, irá aparecer uma mensagem semelhante 

à da Figura 3.35a, onde aparece o registo de conclusão de todos os cálculos de todas as 
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combinações com sucesso. Para prosseguir com o posfemix, deve-se em primeiro lugar fechar 

a janela da mensagem de sucesso do femix, e na segunda janela cmd.exe que irá surgir, deve-se 

utilizar o comando help (ajuda). Este irá apresentar todos os comandos existentes no software 

posfemix(Figura 3.35b). Uma vez que o utilizador esteja contextualizado com o software, pode 

avançar esta etapa da introdução do comando help e escrever diretamente os comandos que 

pretende na janela do posfemix que surge quando se fecha a janela da mensagem de sucesso de 

cálculo.  

  

Figura 3.35 - Início do tratamento de resultados no posfemix. 

Na presente dissertação, foram utilizados diversos comandos na utilização dos posfemix, 

nomeadamente: recsv, dicsv, rslpt, sepva, sapva, hdcsv, dms3d e cps3d. Cada um deles será 

explicado detalhadamente neste tópico, uma vez que foram os principais comandos e os que 

maior importância têm para o efeito desta dissertação. É necessário destacar que, antes de 

prosseguir com o tratamento dos resultados, é necessário calibrar o modelo numérico. Para tal, 

apenas serão necessários os comandos recsv e dicsv.  

3.7.1 - Reações (recsv)  

O comando recsv tem a função de criar um ficheiro em formato excel e de colocar lá todas as 

reações de um determinado ponto da malha de elementos finitos, previamente escolhido pelo 

utilizador (point na Figura 3.36). Se for pretendido as reações para todo os casos de carga em 

N. of load cases (nº de casos de carga) deve-se escrever all. No presente estudo o ponto (point) 

a ser introduzido era o referente ao apoio duplo da viga. Para posteriormente se aceder ao 

ficheiro excel criado com as reações, é necessário abrir a pasta relativa à diretoria do ficheiro 

GID (jobname.gid) e estará nessa mesma diretoria um ficheiro jobname_re com os dados das 

reações para cada combinação.  

b a 
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posfemix > recsv > Introduzir N. of load cases  > Introduzir Point  

Figura 3.36 - Função recsv para cálculo de reações. 

3.7.2 - Deslocamentos (dicsv) 

O comando dicsv tem uma função muito similar ao comando anteriormente descrito. Com efeito 

com este comando é armazenado num ficheiro em formato excel todos os incrementos de 

deslocamento que ocorreram em cada combinação. Este ficheiro irá efetuar uma lista que 

relaciona cada combinação com o respetivo incremento acumulado (para cada combinação o 

valor do deslocamento será sempre a soma dos incrementos das combinações anteriores com o 

incremento da combinação atual). Na Tabela 3.7 apresenta-se o deslocamento total (flecha a 

meio-vão) para as quatro vigas analisadas. Este deslocamento está especificado 

individualmente por combinação no ficheiro jobname_di, na diretoria jobname.gid. 

Para o tratamento dos resultados obtidos no ficheiro em excel quer do comando recsv, quer do 

dicsv, é necessário ter atenção como os valores são apresentados. De seguida será descrito como 

proceder para o tratamento dos dados após a criação do ficheiro excel, uma vez que se tem de 

transformar o “Texto para Colunas”: 

1. Selecionar todos os dados da coluna A da folha de excel jobname_re / jobname_di; 

2. Efetuar procedimento descrito na Figura 3.37. 

 

 
  

 

Dados > Texto para Colunas > Selecionar Delimitado > Selecionar Vírgulas > Selecionar Geral 

> Concluir  

Figura 3.37 - Tratamento dos resultados da função recsv e dicsv no formato Excel. 
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O valor da coluna C da folha de excel, representa a reação em unidades de Newton, no ponto 

da malha escolhido previamente. Na presente dissertação, o passo seguinte foi avaliar a relação 

entre a reação obtida pelo femix e o valor da força aplicada no ensaio experimental. A reação 

representava ½ da força aplicada (F), após efetuar o cálculo segundo a lei da estática (ΣFy=0), 

como se pode analisar na Figura 3.38.  

 

 

 

     ΣFy=0  

  + Reação – F/2=0  

  Reação = F/ 2  

  2 × Reação = F 

Figura 3.38 - Relação da reação no apoio com a força aplicada. 

Uma vez que se tem o conhecimento da relação entre a reação do apoio e a força aplicada, é 

possível construir o gráfico força vs. flecha a meio-vão, uma vez que para cada combinação, 

através das funções recsv e dicsv, existe uma força e o correspondente deslocamento. A 

calibração do modelo numérico é feita comparando a relação força vs. flecha a meio-vão do 

modelo numérico com a relação força vs. flecha a meio-vão obtida nos ensaios experimentais. 

Efetuando uns pequenos ajustes dos parâmetros dos materiais no modelo numérico, tais como 

a energia de fratura do betão, as extensões das armaduras e também nos parâmetros do diagrama 

de tensão de amolecimento em tração do betão, foi possível calibrar o modelo numérico. Na 

Figura 3.39 apresentam-se, a título de exemplo, as curvas numérica e experimental da viga de 

referência (Viga REF), verificando-se uma excelente aproximação entre o os resultados 

numéricos e o experimentais. No capítulo 4 desta dissertação será apresentado o resultado 

obtido para as restantes vigas analisadas. 
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Figura 3.39- Curva força vs. flecha a meio-vão da viga de referência: numérico vs. experimental. 

3.7.3 - Resultados deslocamentos e reações (rslpt) 

O comando rslpt usualmente é utilizado logo após ter terminado o cálculo no femix, uma vez 

que o modelo numérico esteja calibrado. Tem como função criar um ficheiro que guarda todos 

os dados relativos aos deslocamentos e reações, para cada combinação. O procedimento para 

utilizar esta ferramenta é o seguinte: 

i.   posfemix > rslpt > all (premir ENTER) > yes (premir ENTER) 

ii. GID > Postprocess > Window > View Results > Selecionar em View: Contour Fill > 

Displacement ou Reactions > Selecionar a direção pretendida (x, y ou z) e premir Apply. 

Desta forma será possível visualizar graficamente os resultados relativos aos deslocamentos e 

reações, para todas as combinações e para todos os elementos finitos da viga. 

3.7.4 - Tensões (sepva) 

O comando sepva tem como função criar um ficheiro onde irá armazenar as tensões existentes 

nos materiais que se pretender conhecer. Para tal o procedimento é o seguinte: 

i. posfemix > sepva > Default sampling point location (y) > N. of Load cases (all) > Scalar 

field smoothing (y) > Split elements (n) > Group name (1) e premir ENTER; 

ii.  GID > Files > Open multiple > Selecionar os ficheiros …Stress_strain.post.msh e 

Stress_strain.post.res; 

iii.  Window > View Results > Selecionar em View: Contour Fill > Stress > Selecionar direção 

x, y ou z > Apply. 

Referente à opção Group name , o software questiona para qual elemento se pretende extrair as 

tensões lá instaladas. Na presente dissertação pretendia-se analisar as tensões no betão, logo 

deve-se calcular para o Group name 1. 
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Como exemplo de um possível resultado das tensões do betão numa viga, pode-se observar a 

viga de referência da presente dissertação, na combinação 8, referente ao início da cedência das 

armaduras, na Figura 3.40 

 

Figura 3.40 - Representação gráfica das tensões instaladas no betão da viga de referência. 

3.7.5 - Extensões (sapva) 

O comando sapva tem como função criar um ficheiro onde irá armazenar as extensões dos 

elementos pretendidos (betão, armaduras ou CFRP). O procedimento a seguir é semelhante ao 

descrito anteriormente (comando sepva). Como exemplo, na Figura 3.41 apresenta-se para o 

caso da viga de referência, as extensões do betão na direção x referente à combinação 8, 

referente ao início da cedência das armaduras. 

 

Figura 3.41 - Representação gráfica das extensões instaladas no betão da viga de referência. 
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3.7.6 - Histórico das extensões dos elementos finitos (hdcsv) 

O comando hdcsv tem como objetivo extrair as extensões relativas às combinações pretendidas, 

de um determinado elemento escolhido da malha de elementos finitos. Desta forma, é possível 

determinar o seu histórico de extensões. O procedimento necessário para a utilização desta 

função é o seguinte: 

 Após introduzir hdcsv no posfemix, deve-se pressionar “e” e premir ENTER (desta forma é 

escolhido o tipo de modelo não linear – elemento); 

 Introduzir as combinações em que se pretende analisar as extensões (ENTER se se pretende 

para todas as combinações); 

 Introduzir o elemento da malha de elementos finitos; 

 Introduzir o número de pontos de integração (o software tem por defeito dois, para continuar 

é apenas necessário pressionar ENTER); 

Uma vez realizado este procedimento, será criado na diretoria jobname.GID um ficheiro de 

dados com o nome de jobname_..._hd_csv, o qual poderá ser aberto com o excel ou com o bloco 

de notas. 

3.7.7 - Malha deformada (dms3d) 

O comando dms3d tem como objetivo reproduzir a malha de elementos finitos deformada (ver 

exemplo da Figura 3.42), para uma combinação a determinar pelo utilizador. Para que seja 

possível abrir a malha deformada obtida através do posfemix, deve-se abrir o ficheiro 

jobname_dm_s3d, utilizando a função importar com o software drawmesh,. 

 

Figura 3.42 - Representação gráfica da deformação da malha de elementos finitos da viga de 

referência. 
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3.7.8 - Padrão de fendilhação (cps3d) 

O comando cps3d destina-se à apresentação do padrão de fendilhação da estrutura mediante a 

combinação desejada. O padrão de fendilhação pode conter fendas em diferentes estados, isto 

é, as fendas podem ser iniciais (initiating), podem estar a abrir (opening), podem estar a fechar 

(closing), podem já estar fechadas (closed), podem estar a voltar a abrir (reopening) ou podem 

estar completamente abertas (fully open). Na Figura 3.43 consegue-se observar cada uma das 

fases das fendas acima descritas. 

 

Figura 3.43 - Estados das fendas (Sena Cruz, 2004). 

Na Figura 3.44 apresenta-se a título de exemplo a comparação entre o padrão de 

fendilhação final instalado na viga de referência obtido experimentalmente (fotografia) e o 

padrão de fendilhação final instalado na viga de referência obtido numericamente. 

 

 

Figura 3.44 - Padrão de fendilhação experimental (em cima) e numérico (em baixo) da viga de 

referência. 
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Estes oito comandos do posfemix acima explicados detalhadamente, foram cruciais no 

tratamento dos resultados obtidos através do femix para esta dissertação. O software GID tem 

ainda outra potencialidade que possibilita a criação de um vídeo sequencial para a deformação 

da viga ao longo das combinações. Esta animação de vídeo é feita da seguinte forma: 

i. Deformação da malha de elementos finitos (Figura 3.45): 

 posfemix > rslpt > Window > View Results > Displacement > X,Y ou Z > Main Mesh > 

Selecionar Deformed > Apply; 

ii. Vídeo sequencial da deformação da malha: 

 Window > Animate > pressionar ícone Play. 

É necessário que se cumpra o tópico i (deformação da malha de elementos finitos) antes de 

proceder para o tópico ii (vídeo sequencial da deformação da malha). Para acelerar o vídeo é 

apenas necessário reduzir o delay between steps que representa a duração de tempo entre a 

passagem de cada combinação, uma vez que o valor utilizado por defeito é demasiado longo 

(200ms). O aconselhável será entre 50 a 100 ms. 

 

Figura 3.45 - Representação gráfica dos deslocamentos na direção Y da viga de referência. 

O objetivo deste capítulo foi descrever todo o procedimento que conduziu à calibração do 

modelo numérico e modelação do comportamento das quatro vigas ensaiadas 

experimentalmente por Dias et al. (2012). Na primeira parte do Capítulo 4 desta dissertação 

serão apresentados os resultados da referida modelação.  
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Capítulo 4 
Resultados Numéricos vs. Resultados experimentais e Estudos 

Paramétricos 

4.1 - Introdução 

Neste capítulo serão apresentados os resultados obtidos na modelação de quatro vigas de betão 

armado, uma de referência sem reforço de CFRP e três reforçadas à flexão com laminados de 

CFRP inseridos: a viga S1-M com 1 laminado, a viga S2-M com dois laminados e a viga S3-M 

reforçada com três laminados de acordo com a disposição apresentada na Figura 2.14 do 

Capítulo 2 desta dissertação. Os resultados obtidos via modelação numérica serão comparados 

com os resultados experimentais obtidos por Dias et al. (2012) em termos da relação força vs. 

flecha a meio-vão das vigas, do padrão de fendilhação final instalado nas vigas, da força 

correspondente ao início de fendilhação do betão, da força correspondente à entrada em 

cedência das armaduras longitudinais tracionadas, a força máxima suportada pelas vigas e 

respetiva flecha a meio-vão. Tendo como base a modelação numérica anteriormente referida, 

neste capítulo também serão apresentados os resultados de um estudo paramétrico efetuado por 

forma a avaliar a influência de um conjunto de parâmetros no desempenho de vigas de betão 

armado reforçadas à flexão com laminados de CFRP inseridos: a classe de resistência do betão, 

a percentagem de armadura longitudinal e a percentagem de CFRP. 

4.2 - Resultados numéricos vs. resultados experimentais referentes às vigas testadas por Dias et 

al. (2012) 

Nesta secção será feita uma comparação entre os resultados obtidos numericamente e os 

resultados obtidos experimentalmente nas vigas ensaiadas por Dias et al. (2012). A modelação 

das vigas foi feita de acordo com o descrito no Capítulo 3 desta Dissertação. A comparação 

“numérico vs. experimental” será feita em termos da relação força vs. flecha a meio-vão das 

vigas, do padrão de fendilhação final instalado nas vigas, da força correspondente ao início de 

fendilhação do betão, da força correspondente à entrada em cedência das armaduras 

longitudinais tracionadas, a força máxima suportada pelas vigas e respetiva flecha a meio-vão.  
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4.2.1 - Relação força vs flecha a meio-vão 

Na Figura 4.1 apresenta-se, para cada uma das quatro vigas analisadas (viga de referência, viga 

S1-M, viga S2-M e viga S3-M), a relação força vs. flecha a meio-vão em termos numérico e 

experimental. Na Figura 4.2 apresenta-se a relação força vs. flecha a meio-vão, numérica e 

experimental das quatro vigas anteriormente referidas.  

.  

 

a) Viga de referência. 

 

b) Viga S1-M. 
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c) Viga S2-M. 

 

d) Viga S3-M. 

Figura 4.1 - Relação força vs. flecha a meio-vão de cada uma das vigas analisadas (numérico vs. 

experimental). 

 

Figura 4.2 - Relação flecha a meio-vão vs. força das 4 vigas ensaiadas numericamente e 

experimentalmente. 

Após a análise das Figuras 4.1 e 4.2, é possível concluir que as curvas numéricas das vigas 

reforçadas com CFRP, à semelhança do que se registou experimentalmente, apresentam três 

fases distintas de comportamento: até à fendilhação do betão (Fase 1), entre a fendilhação do 
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betão e a cedência das armaduras (Fase 2) e entre a cedência das armaduras e a carga máxima 

(Fase 3), com uma diminuição sucessiva da rigidez ao passar de uma fase para outra (da fase 1 

até à fase 3). A diminuição de rigidez na terceira fase foi tanto maior quanto menor a 

percentagem de CFRP. Relativamente à terceira fase das curvas força vs. flecha a meio-vão das 

vigas S2-M e S3-M, é possível observar que existe um desfasamento considerável quanto à 

carga máxima resistente e respetiva flecha a meio-vão, entre o valor experimental e o valor 

numérico. A explicação para este acontecimento resume-se ao modo de rotura adotado para a 

calibração dos modelos numéricos, isto é, para a viga S1-M, uma vez que no ensaio 

experimental, a viga teve como modo de rotura a rotura do laminados CFRP, esta foi calibrada 

numericamente para ter como modo de rotura, a rotura dos laminados de CFRP. Para que os 

resultados dos estudos paramétricos que posteriormente se iriam fazer, tivessem credibilidade 

científica, os laminados de CFRP das vigas S2-M e e S3-M tiveram exatamente as mesmas 

características que as características utilizadas na viga S1-M (tensão e extensão de rotura, assim 

como respetivo módulo de elasticidade). Uma vez que no ensaio laboratorial, as vigas S2-M e 

S3-M obtiveram modos de rotura por destacamento dos laminados CFRP do betão de 

recobrimento, estas não utilizaram a totalidade da capacidade resistente dos laminados 

aplicados como reforço nas vigas, durante o carregamento. Dado que o software utilizado não 

permite simular numericamente vigas que tenham como modo de rotura o destacamento do 

CFRP, os resultados numéricos obtidos para a viga S2-M e S3-M referem-se ao máximo 

aproveitamento das capacidades resistentes dos laminados de CFRP, tendo estas vigas como 

modo de rotura, a rotura dos laminados CFRP.  

Em termos de condições de serviço, as quatro vigas obtiveram resultados numéricos com 

aproximações muito elevadas aos resultados experimentais, o mesmo não se passou 

relativamente em termos de estado limite último, designadamente nas vigas S2-M e S3-M, 

como foi acima explicado. 

4.2.2 - Padrão de fendilhação final instalado nas vigas 

Nas Figuras 4.3, 4.4, 4.5 e 4.6 apresenta-se, respetivamente, para as vigas de referência, S1-M, S2-M e S3-

M a comparação entre o padrão de fendilhação final registado nos ensaios experimentais com o padrão de 

fendilhação final instalado nas vigas obtido numericamente. De acordo com as fotografias das Figuras 4.3, 

4.4, 4.5 e 4.6, os modos de rotura que ocorreram nas vigas nos ensaios experimentais realizados foram: 

esmagamento do betão na viga de referência; rotura do CFRP na viga S1-M, destacamento do CFRP nas 

vigas S2-M e S3-M. 
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a) 

 

b) 

Figura 4.3 - Padrão de fendilhação final instalado na viga de referência: a) verificado no ensaio 

experimental; b) obtido no âmbito da modelação numérica. 

 

 

a) 

 

b) 

Figura 4.4 - Padrão de fendilhação final instalado na viga S1-M: a) verificado no ensaio 

experimental; b) obtido no âmbito da modelação numérica. 
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a) 

 

b) 

Figura 4.5 - Padrão de fendilhação final instalado na viga S2-M: a) verificado no ensaio 

experimental; b) obtido no âmbito da modelação numérica. 

 

 

a) 

 

b) 

Figura 4.6 - Padrão de fendilhação final instalado na viga S3-M: a) verificado no ensaio 

experimental; b) obtido no âmbito da modelação numérica. 
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4.2.3 - Tensões e extensões nas armaduras 

As tensões e extensões de um material são os parâmetros que controlam o seu comportamento 

quando este está sujeito a esforços. Por este motivo, estes valores têm de ser controlados, de 

forma a que o material tenha o comportamento desejado e já devidamente previsto quando 

ensaiado. Na Tabela 4.1 estão apresentadas as tensões e a extensões máximas para o aço, 

determinadas através do software de cálculo posfemix. As extensões máximas para o CFRP são 

já conhecidas (0.025) uma vez que o modo de rotura dos modelos numéricos de todas vigas 

reforçadas foi a rotura do laminado CFRP. 

Tabela 4.1 - Tensões e extensões máximas numéricas no aço na direção X para as quatro vigas 

ensaiadas. 

Vigas Extensão X Tensão X (MPa) 

referência 1.15E-03 217.2 

S1-M 3.05E-03 483.2 

S2-M 4.16E-03 564.0 

S3-M 3.88E-03 513.7 

A Figura 4.7 representa graficamente os valores obtidos para as extensões do aço apresentadas 

na Tabela 4.1, comparando estes com a extensão máxima das armaduras longitudinais de tração, 

de forma a demonstrar que estas estavam abaixo da sua extensão rotura. 

 

Figura 4.7 - Tensões e extensões máximas numéricas no aço na direção X para as quatro vigas 

ensaiadas. 
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Das tensões e extensões extraídas do software de cálculo, podem-se retirar as seguintes 

conclusões: 

 A Viga S2-M foi a viga em que se verificou a máxima extensão nas armaduras com 4.16E-

3, como se pode observar na Figura 4.7, ficando abaixo da extensão ultima definida para a 

armadura de 5.0E-2; 

 A máxima tensão nas armaduras ocorreu na viga S2-M, com 564 MPa ficando abaixo da 

tensão de rotura das armaduras de 661 MPa; 

4.2.4 -  Carga de fendilhação, carga de cedência das armaduras, carga máxima e respetiva 

flecha a meio-vão 

Na Tabela 4.2 apresentam-se, para cada uma das vigas analisadas, os valores obtidos na 

modelação numérica (Num.) e experimentalmente (Exp.) da carga de início de fendilhação do 

betão (Fcr), da carga correspondente ao início da cedência das armaduras (Fsy), da carga máxima 

resistente da viga (Fmax) e respetiva flecha meio-vão (uFmax). Além disso, na referida tabela 

também se apresenta o valor do erro dos resultados numéricos em relação aos experimentais. 

Referente à Tabela 4.3, apresenta-se nesta a flecha a meio-vão numérica e a flecha a meio-vão 

experimental das 4 vigas ensaiadas, assim como o erro entre estes. Na Tabela 4.4 apresenta-se, 

em função da percentagem de CFRP (ρf), o valor dos acréscimos de carga, numérico e 

experimental, proporcionados pelas soluções de reforço testadas em termos de carga de 

cedência das armaduras e carga máxima. Os referidos acréscimos, em função da percentagem 

de CFRP estão também representados na Figura 4.8. 

Tabela 4.2 - Carga de fendilhação, carga de cedência das armaduras e carga máxima. 

Vigas 
Fcr (kN) Erro 

(%) 

Fsy (kN) Erro 

(%) 

Fmax (kN) Erro 

(%) Num. Exp. Num. Exp. Num. Exp. 

Referência 21.36 20.10 6.3 55.76 56.60 1.5 61.60 62.30 1.1 

S1-M 21.54 21.00 2.6 63.39 62.40 1.6 86.33 88.40 1.7 

S2-M 22.14 22.20 0.3 69.24 69.50 0.4 114.84 111.90 2.6 

S3-M 22.54 24.00 6.1 75.42 76.00 0.8 141.93 126.60 12.1 
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Tabela 4.3 - Flecha a meio-vão numérica vs. experimental correspondente à carga máxima das quatro 

vigas. 

Vigas 
u F max (Num.) 

(mm) 

u F max (Exp.) 

(mm) 
Erro (%) 

Referência 45.00 45.10 0.22 

S1-M 41.40 41.20 0.49 

S2-M 49.05 43.60 12.50 

S3-M 52.75 38.90 35.60 

Tabela 4.4 - Variação dos acréscimos de carga de cedência das armaduras e da carga máxima 

aumentando a percentagem de CFRP. 

Vigas 
ρf 

(%) 

Acréscimo de carga de cedência das 

armaduras (%) 
Acréscimo carga máxima (%) 

Numérico  Experimental Numérico  Experimental 

S1-M 0.03 14 10 41 42 

S2-M 0.06 24 23 86 80 

S3-M 0.09 35 34 130 103 

 

 

Figura 4.8 - Variação dos acréscimos de carga de cedência das armaduras e da carga máxima 

aumentando a percentagem de CFRP. 
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conclusões: 
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utilizado nas vigas, este tem mais influência para o acréscimo de carga máxima do que para 

o acréscimo de carga de cedência das armaduras; 
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cedência das armaduras, a média destes foi 3.8% e 1.0% respetivamente. Para a carga 

máxima resistente da viga, o erro médio foi de 4.4%, sendo este o maior erro médio, logo 

pode-se concluir que existir uma melhor aproximação entre os resultados numéricos e 

experimentais a nível de estado limite de serviço do que para o estado limite último. Isto 

deveu-se ao facto de o modelo numérico não simular destacamentos do laminado CFRP 

como modo de rotura, fazendo com que os valores de Fmax de S2-M e S3-M sejam 

superiores do que o que realmente aconteceu na atividade experimental, visto que o critério 

de paragem dos modelos numéricos utilizados é a rotura do laminado CFRP e não o 

destacamento do laminado do betão de recobrimento.  

 A partir da Tabela 4.3 é possível concluir que quanto maior for a percentagem de CFRP, 

maior será a flecha a meio-vão numérica (varia entre 45 a 52,75 mm, Viga de Referência e 

S3-M, respetivamente), contrariamente ao que acontece com a flecha a meio-vão 

experimental (varia entre 45 a 38,90mm, Viga de Referência e S3-M, respetivamente), 

devendo ao facto referido no ponto anterior (Modo de rotura calibrado no modelo numérico 

vs. modo de rotura dos modelos experimentais). Por este motivo, o erro para a viga S1-M 

(0.49%) entre a flecha numérica e a experimental são menores do que os erros para as vigas 

S2-M e S3-M (12.50 e 35.60%, respetivamente), uma vez que a viga S1-M teve o mesmo 

modo de rotura de modelo numérico e modelo experimental, isto é, modo de rotura da viga 

devido à rotura do laminado CFRP. 

4.3 - Estudos paramétricos 

Tendo como base a calibração do modelo efetuado no âmbito da modelação do comportamento das quatro 

vigas testadas por Dias et al. (2012), nesta secção serão apresentados os resultados de um estudo 

paramétrico efetuado por forma a avaliar a influência de um conjunto de parâmetros no comportamento 

de vigas de betão armado reforçadas à flexão com laminados de CFRP inseridos. Os referidos parâmetros 

são a classe de resistência do betão, a percentagem de armadura longitudinal e a percentagem de CFRP. 

Para cada um destes parâmetros, foram mantidas todas as características das quatro vigas (referência, S1-

M, S2-M e S3-M) usadas na sua modelação numérica apresentada anteriormente, fazendo variar apenas 

o parâmetro em análise (classe de resistência do betão ou percentagem de armadura longitudinal ou 

percentagem de reforço de CFRP). 
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4.3.1 - Classe de betão 

O betão das quatro vigas ensaiadas experimentalmente por Dias et al. (2012) tinha uma resistência média 

à compressão de 50.2 MPa (fcm=50.2MPa), ou seja, de acordo com a EN 1992-1-1 (2004) era um betão 

da classe C40/50. No âmbito do presente estudo paramétrico em termos da avaliação do efeito da classe 

de resistência do betão, foram avaliadas as seguintes classes: C12/15, C20/25, C30/37 e C40/50. Os 

parâmetros que foram necessários alterar na modelação das quatro vigas em análise para avaliar o efeito 

da classe de resistência do betão foram o valor médio da resistência à compressão do betão (fcm), o valor 

médio da resistência à tração do betão (fctm), o módulo de elasticidade do betão (E) e a energia de fratura 

(Gf), como de pode observar na Tabela 4.5. Os valores de fctm , fctm e E foram obtidos na EN 1992-1-1 

(2004), enquanto o valor da energia de fratura (Gf) foi determinado de acordo com o Model Code for 

Concrete Structures 2010 (MC2010, 2010) por intermédio da equação (4.1): 

𝐺𝑓 = 73×𝑓𝑐𝑚0.18                                                                (4.1) 

Tabela 4.5 - Parâmetros relativos aos tipos de betão utilizados no estudo paramétrico das vigas. 

Classe de betão fcm (MPa) fct (MPa) E (GPa) Gf (N/mm) 

C12/15 20 1.6 27 0.125 

C20/25 28 2.2 30 0.133 

C30/37 38 2.9 33 0.141 

C40/50 50.2 3.6 35 0.148 

As Tabelas 4.6, 4.7, 4.9 e 4.10 referem-se aos principais resultados obtidos para o estudo 

paramétrico relativo às classes de betão, nomeadamente a carga de fendilhação, a carga de início 

de cedência das armaduras, a carga máxima resistente e a flecha a meio-vão das vigas. 

Tabela 4.6 - Principais resultados obtidos através do estudo paramétrico avaliando a classe de betão 

para a viga de referência. 

Classe de betão Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

C12/15 15.18 55.77 61.04 45 

C20/25 18.11 57.08 61.74 41.9 

C30/37 21.48 58.23 61.99 37.7 

C40/50 22.56 60.13 61.11 34.6 
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Tabela 4.7 - Principais resultados obtidos através do estudo paramétrico avaliando a classe de betão 

para a viga S1-M. 

Classe de betão Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

C12/15 15.34 60.47 86.36 43.3 

C20/25 18.15 61.52 87.22 42.2 

C30/37 21.58 62.23 87.76 41.1 

C40/50 22.67 65.39 87.07 39.35 

Tabela 4.8 - Principais resultados obtidos através do estudo paramétrico avaliando a classe de betão 

para a viga S2-M. 

Classe de betão Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

C12/15 15.80 65.09 113.40 49.3 

C20/25 18.99 66.31 114.50 48.65 

C30/37 22.46 67.43 115.30 46.6 

C40/50 23.50 69.12 115.11 45.15 

Tabela 4.9 - Principais resultados obtidos através do estudo paramétrico avaliando a classe de betão 

para a viga S3-M. 

Classe de betão Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

C12/15 16.16 69.75 140.98 52.5 

C20/25 19.30 71.36 141.73 52.1 

C30/37 22.78 72.73 142.79 49.55 

C40/50 24.06 74.34 142.17 49.45 

As Figuras 4.9, 4.10, 4.11 e 4.12 representam graficamente a relação força vs. flecha a meio-vão para cada 

classe de betão, para as quatro vigas. 

 

Figura 4.9 - Relação força vs. flecha a meio-vão para a classe de betão C12/15. 
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Figura 4.10 - Relação força vs. flecha a meio-vão para a classe de betão C20/25. 

 

Figura 4.11 - Relação força vs. flecha a meio-vão para a classe de betão C30/37. 

 

Figura 4.12 - Relação força vs. flecha a meio-vão para a classe de betão C40/50. 
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a classe de betão, para cada viga foi de 1.6%, 1.6%, 1.7% e 1.3%, respetivamente para a viga de 

referência, viga S1-M, viga S2-M e viga S3-M; 

 Para cada viga, quanto maior for a classe de betão utilizada, menor será a flecha a meio-vão. 

Tabela 4.10 - Acréscimos de carga dos principais resultados avaliando a classe de betão das vigas. 

Classe de 

betão 

S1-M S2-M S3-M 

ΔFcr 

(%) 

ΔFsy 

(%) 

ΔFmax 

(%) 

ΔFcr 

(%) 

ΔFsy 

(%) 

ΔFmax 

(%) 

ΔFcr 

(%) 

ΔFsy 

(%) 

ΔFmax 

(%) 

C12/15 1.56 8.44 41.48 10.13 16.71 85.77 15.03 25.08 130.96 

C20/25 1.52 7.77 40.13 5.07 16.18 83.95 6.65 25.02 127.70 

C30/37 1.15 6.86 39.62 4.00 15.79 83.44 5.23 24.91 127.18 

C40/50 1.16 5.96 42.48 2.87 14.95 88.36 6.41 23.63 132.64 

Na Tabela 4.10 apresentam-se, para as soluções de reforço com 1 (viga S1-M), 2 (viga S2-M) e 3 (viga 

S3-M) laminados, os resultados dos acréscimos verificados em termos de carga de início de fendilhação 

(ΔFcr), de carga de cedência das armaduras (ΔFsy) e de carga máxima (ΔFmax), quando se varia a classe de 

resistência do betão, designadamente, considerando que as vigas tinham um betão C12/15, C20/25, 

C30/37 e C40/50. Estes acréscimos foram obtidos tendo como base os valores verificados nas respetivas 

vigas de referência. Os acréscimos ΔFsy e ΔFmax para as soluções de reforço com 1, 2 e 3 laminados, em 

função da classe de resistência do betão, estão representados nas Figuras 4.13, 4.14, 4.15, respetivamente. 

Analisando a Tabela 4.10, podem ser retiradas as seguintes conclusões: 

 Quanto melhor for a classe de betão, menor será o acréscimo da carga de cedência das armaduras, 

assim como menor será o acréscimo de início de fendilhação do betão, para a mesma percentagem de 

reforço, comparativamente com a viga de referência; 

 Os acréscimos de carga máxima têm diminuições até à classe de betão C30/37, aumentando apenas 

para na classe de betão C40/50, comparativamente com a viga de referência. Isto deve-se ao facto do 

valor de carga máxima da viga de referência, com um betão de classe C40/50, ser um valor 

relativamente baixo. 
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Figura 4.13 - Acréscimos de carga de cedência das armaduras e de carga máxima resistente da viga 

S1-M. 

 

Figura 4.14 - Acréscimos de carga de cedência das armaduras e de carga máxima resistente da viga 

S2-M. 

 

Figura 4.15 - Acréscimos de carga de cedência das armaduras e de carga máxima resistente da viga 

S3-M. 

Analisando as Figuras 4.13, 4.14 e 4.15, denota-se que: 

 O aumento dos acréscimos de carga máxima são maiores, comparativamente com os acréscimos de 

cedência das armaduras, quando se aumenta a percentagem de reforço CFRP. 

 

 

0

20

40

60

80

100

120

140

0 10 20 30 40 50 60

A
cr

és
ci

m
o

 d
e 

ca
rg

a 
(%

)

fcm (MPa)

ΔFsy

ΔFmax

0

20

40

60

80

100

120

140

0 10 20 30 40 50 60A
cr

és
ci

m
o

 d
e 

ca
rg

a 
(%

)

fcm (MPa)

ΔFsy

ΔFmax

0

20

40

60

80

100

120

140

0 10 20 30 40 50 60A
cr

és
ci

m
o

 d
e 

ca
rg

a 
(%

)

fcm (MPa)

ΔFsy

ΔFmax



76   Capítulo 4  

 

 

 

Tabela 4.11 - Acréscimo de carga de início de fendilhação do betão das vigas em percentagem. 

fcm 

Referência S1-M S2-M S3-M 

Fcr 

(kN) 
ΔFcr 

Fcr 

(kN) 
ΔFcr  

Fcr 

(kN) 
ΔFcr 

Fcr 

(kN) 
ΔFcr  

C12/15 15.18 - 15.34 - 15.80 - 16.16 - 

C20/25 18.11 19.29 18.15 18.36 18.99 20.13 19.30 19.39 

C30/37 21.48 41.49 21.58 40.73 22.46 42.14 22.78 40.93 

C40/50 22.56 48.64 22.67 47.83 24.96 57.91 25.25 56.18 

Tabela 4.12 - Acréscimo de carga cedência das armaduras das vigas em percentagem. 

fcm 

Referência S1-M S2-M S3-M 

Fsy 

(kN) 
ΔFsy  

Fsy 

(kN) 
ΔFsy 

Fsy 

(kN) 
ΔFsy  

Fsy 

(kN) 
ΔFsy  

C12/15 55.77 - 60.47 - 65.09 - 69.75 - 

C20/25 57.08 2.36 61.52 1.73 66.31 1.89 71.36 2.30 

C30/37 58.26 4.42 62.23 2.90 67.43 3.60 72.73 4.27 

C40/50 60.13 7.82 65.39 8.13 69.12 6.20 74.34 6.57 

Tabela 4.13 - Acréscimo de carga máxima resistente das vigas em percentagem. 

fcm 

Referência S1-M S2-M S3-M 

Fmax 

(kN) 
ΔFmax 

Fmax 

(kN) 
ΔFmax 

Fmax 

(kN) 
ΔFmax  

Fmax 

(kN) 
ΔFmax  

C12/15 61.04 - 86.36 - 113.40 - 140.98 - 

C20/25 61.74 1.10 87.22 1.00 114.50 0.98 141.73 0.53 

C30/37 61.99 1.60 87.76 1.62 115.30 1.68 142.79 1.29 

C40/50 61.11 0.12 87.07 0.83 115.11 1.51 142.17 0.85 

Após a apresentação das Tabelas 4.11, 4.12 e 4.13, é possível avaliar a contribuição de cada classe de 

betão, para cada viga individualmente, tendo como referência a classe de betão de menor qualidade, a 

classe C12/15. Relativamente às tabelas apresentadas, podem ser retiradas as seguintes conclusões: 

 O acréscimo de carga necessária para início de fendilhação do betão e o acréscimo carga de cedência 

das armaduras aumentam, quanto maior for a classe de betão, para as quatro vigas, promovendo então 

benefícios ao nível de estado limite de serviço (Tabela 4.11 e Tabela 4.12); 

 Através da Tabela 4.13, utilizando os modelos numéricos calibrados, é possível concluir que o aumento 

da qualidade do betão utilizados nas vigas, provoca uma alteração muito reduzida às cargas máximas 

resistentes das vigas, uma vez que a média de todos os acréscimos de carga máxima calculados é igual 

a 1.1%. 
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 O facto dos acréscimos das cargas máximas apresentados na Tabela 4.13 de cada viga, terem valores 

muito semelhantes para as suas respetivas 4 classes de betão analisadas, apenas é possível uma vez que 

os modelos numéricos estão calibrados de forma a que o modo de rotura seja por rotura do laminado 

de CFRP e não por destacamento do CFRP. Na realidade, em laboratório, quando a rotura da viga 

ocorre devido ao destacamento do CFRP do betão de recobrimento (exemplo das vigas S2-M e S3-

M), utilizando um betão de classe inferior, o destacamento do laminado de CFRP ocorre 

prematuramente. Isto é, quando a rotura da viga é por destacamento do laminado de CFRP do betão 

de recobrimento, quanto maior a classe de betão, maior será o acréscimo de carga máxima, uma vez 

que o destacamento do laminado acontecerá mais tarde e por sua vez, maior será a flecha a meio-vão. 

4.3.2 - Percentagem de CFRP 

A percentagem de CFRP referente às soluções de reforço com 1 (viga S1-M), 2 (viga S2-M) e 3 (viga S3-

M) laminados com dimensões de 1.4×10 mm2 era de 0.03%, 0.06% e 0.09%, respetivamente. Além destas 

percentagens de reforço, no presente estudo paramétrico foi analisada mais uma percentagem de reforço 

correspondente à inserção de quarto laminados com de 1.4×10 mm2 (viga S4-m). A esta solução de reforço 

corresponde uma percentagem de CFRP de 0.12%. À exceção do número de laminados, todas as restantes 

características desta viga foram consideradas iguais às vigas S1-M, S2-M e S3-M para efetuar o estudo 

paramétrio referente à percentagem de CFRP. 

Após o cálculo numérico da viga reforçada com 4 laminados de CFRP, foram obtidos os resultados 

apresentados na Figura 4.16. Na tabela 4.14 está resumida a informação referente à carga de início de 

fendilhação do betão, carga de início de cedência das armaduras e carga máxima resistente da viga, assim 

como os respetivos acréscimos de carga relativos à carga de inicio de cedência das armaduras e carga 

máxima resistente da viga. 

 

Figura 4.16 - Relação força vs. flecha a meio-vão para diferentes percentagens de CFRP. 
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Relativamente à Figura 4.16, estão apresentados graficamente os resultados força vs. flecha a meio-vão 

para as 5 vigas estudadas no âmbito do tópico do estudo paramétrico avaliando a influência da 

percentagem de CFRP. O modo de rotura utilizado numericamente para as 4 vigas reforçadas foi a rotura 

dos laminados de CFRP. 

Tabela 4.14 - Principais resultados para cada percentagem de CFRP utilizado no reforço das vigas. 

Percentagem de CFRP (%) Fcr (kN) ΔFcr (%) Fsy (kN) ΔFsy (%) Fmax (kN) ΔFmax (%) 

0.00 21.36 - 55.76 - 61.60 - 

0.03 21.54 0.81 63.39 13.67 86.33 40.14 

0.06 22.14 3.65 69.24 24.17 114.84 86.43 

0.09 22.54 5.50 75.42 35.26 141.93 130.41 

0.12 22.59 5.19 81.32 45.83 169.26 174.76 

 

Figura 4.17 - Principais resultados para cada percentagem de CFRP utilizado no reforço das vigas. 

Analisando a Tabela 4.14 e a Figura 4.17, é possível retirar as seguintes conclusões: 

 O aumento da percentagem de reforço de CFRP, provoca uma alteração muito reduzida na carga de 

início de fendilhação do betão, obtendo valores de acréscimo entre 0.81% e 5.50%, respetivamente a 

viga S1-M e a viga S3-M. Com o aumento de um quarto laminado (viga S4-M) o acréscimo de carga 

de início de fendilhação foi ainda inferior ao acréscimo da viga S3-M (5.19%). 

 Quando se aumenta a percentagem de reforço CFRP, o acréscimo de carga de cedência das armaduras 

e o acréscimo de carga máxima aumentam; 

 Quanto maior é a percentagem de reforço de CFRP, o aumento do acréscimo para a carga máxima é 

maior que o aumento do acréscimo da carga de início de cedências das armaduras e muito maior para 

o aumento do acréscimo de carga de início de fendilhação. 

Na Figura 4.18 será apresentada a informação referente aos acréscimos relativos de carga máxima. Os 

acréscimos relativos de carga máxima referem-se à percentagem de acréscimo que cada laminado de 

CFRP acrescenta quando adicionado a viga de betão armado. Desta forma, será possível analisar qual a 
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percentagem de reforço que tem maior influência na carga máxima resistente da viga. De seguida será 

apresentada a equação que calcula os acréscimos relativos de carga máxima (4.2), em que i representa o 

número de laminados de reforço da viga, variando entre 0 e 3 (nota: ΔFmax,(i) para i=0, representa o 

acréscimo de força máxima da viga de referência): 

Δrelativo,Fmax (i+1) = ΔFmax,(i+1) - ΔFmax,(i)                                                                                     (4.2) 

 

Figura 4.18 - Acréscimos relativos de Fmax para as quatro vigas reforçadas com CFRP. 

Analisando a Figura 4.18, podem ser retiradas as seguintes conclusões relativas aos acréscimos 

relativos de carga máxima: 

 A viga com uma percentagem de reforço de CFRP de 0.06% (S2-M) é a viga que obteve o 

maior acréscimo de força máxima resistente relativamente as restantes vigas (Figura 4.18) 

com 46%, o que indica que o reforço com dois laminados de CFRP, para a geometria da viga 

em estudo, é o que mais influência tem para o acréscimo de carga máxima; 

 Ao acrescentar um quarto laminado como reforço, a carga máxima resistente da viga 

aumentou, mas o acréscimo relativo de carga máxima entre a viga S3-M e a viga S4-m foi 

igual ao acréscimo relativo entre a viga S2-M e a viga S3-M (44%), como se pode observar 

na Figura 4.18. Com isto, é possível concluir que ao adicionar mais laminados de CFRP, o 

acréscimo relativo da carga máxima não aumenta, mas sim tenderá a diminuir (sendo o modo 

de rotura da viga a rotura do laminado de CFRP). Caso o modelo numérico pudesse simular 

o destacamento dos laminados de CFPR do betão de recobrimento, os acréscimos relativos 

da carga máxima seriam cada vez menores, à medida que se aumentava a percentagem de 

reforço de CFRP nas vigas em estudo. 
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4.3.3- Percentagem de armadura longitudinal 

A percentagem de armadura longitudinal (ρsl) utilizada nas vigas ensaiadas é de 0.38%, que representa 2 

varões de 10mm de diâmetro para as armaduras longitudinais de tração.  Para o caso de estudo 1, será 

simulada uma percentagem de armadura longitudinal de tração igual a 0.249%, que representam 2 varões 

de 8mm e para o caso de estudo 2 será utilizada uma percentagem de armadura longitudinal de 0.561%, 

que representa 2 varões de 12mm para as armaduras longitudinais de tração. Para a escolha das 

percentagens de armadura longitudinal a avaliar, foi necessário calcular a armadura longitudinal mínima 

da viga, para que a menor percentagem avaliada fosse superior à armadura mínima. Para o cálculo foi 

utilizada a expressão 4.3, presente no Eurocódigo 2 (EN 1992-1-1, 2004). 

As,min = 0.26 * fctm / fyk * bt * d ≥ 0.0013 * bt * d                                          (4.3) 

 

Na expressão 4.3 têm-se que: 

 As, min é a área mínima de armadura longitudinal de uma viga (mm2); 

 fctm é o valor médio da tensão de rotura à tração do betão (MPa); 

 fyk é o valor característico da tensão de cedência do aço (MPa); 

 bt é o valor da largura da secção transversal da viga (m); 

 d é o valor da distância da fibra de betão mais comprimida ao baricentro dos varões de aço da armadura 

longitudinal de tração (m).  

Na Tabela 4.15 apresentam-se os valores das grandezas necessárias para o cálculo da armadura mínima 

da viga em estudo. 

Tabela 4.15 - Dados para cálculo da armadura longitudinal mínima para a viga em estudo. 

fctm (MPa) fyk (MPa) d (m) bt (m) 

3.2 500 0.269 0.150 

 

De acordo com os dados da Tabela 4.15, a área de armadura longitudinal de tração mínima, para a viga 

em estudo, era de 6,7x10-5 m2.  A área de armadura longitudinal utilizada para a menor percentagem de 

armadura longitudinal (0.249%) foi de 10.05x10-5m2, logo pode-se concluir que a menor percentagem de 

armadura utilizada neste estudo é superior à armadura mínima e desta forma pode ser simulada nos estudos 

paramétricos desta dissertação.  

Os parâmetros das tensões e extensões relacionados com as armaduras longitudinais utilizados no estudo 

paramétrico relacionado com a percentagem de armadura longitudinal estão apresentados na Tabela 4.16, 

respetivamente para cada diâmetro utilizado: 
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Tabela 4.16 - Tensões e extensões dos varões utilizados no estudo paramétrico relativo à percentagem 

de armadura. 

Diâmetro dos varões de aço 8mm 10mm 12mm 

εsy 2.67E-03 3.00E-03 3.00E-03 

fsy (MPa) 534.5 566.7 600 

εsh 1.00E-02 1.00E-02 1.00E-02 

fsh (MPa) 550 600 620 

εsu 5.00E-02 5.00E-02 5.00E-02 

fsu (MPa) 618.5 661.3 680 

A relação força vs. flecha a meio-vão de uma viga é um fator importante que deve ser tido em 

consideração nas análises dos resultados numéricos. Como se pode observar na Figuras 4.19, 

4.20, 4.21 e 4.22, respetivamente para a viga de referência, viga S1-M, viga S2-M e viga S3-

M, foram determinadas para cada viga, as quatro curvas força vs. flecha a meio-vão associadas 

a cada diâmetro dos varões utilizados nas armaduras longitudinais de tração, nomeadamente 

para a armadura mínima, para varões de 8mm, para varões de 10mm e para varões de 12mm. 

Com estes gráficos será possível comparar o comportamento de cada viga individualmente, 

fazendo apenas as respetivas simulações de percentagem de armadura longitudinal de tração 

utilizada.  

 

 

Figura 4.19 - Relação força vs. flecha a meio-vão da viga de referência. 
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Figura 4.20 - Relação força vs. flecha a meio-vão da viga S1-M. 

 

Figura 4.21 - Relação força vs. flecha a meio-vão da viga S2-M. 

 

Figura 4.22 - Relação força vs. flecha a meio-vão da viga S3-M. 

Após o cálculo das cargas de início de fendilhação, das cargas de cedência de armaduras e das 

cargas máximas resistentes de todas as simulações das quatro diferentes percentagens de 

armadura longitudinal para as quatro vigas em estudo (Tabelas 4.17, 4.18, 4.19 e 4.20), os 

resultados dos acréscimos de carga foram organizados, tendo como ponto de comparação a viga 

de referência, como se pode observar na Tabela 4.21. 
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Tabela 4.17 - Principais resultados obtidos no estudo paramétrico da percentagem de armadura 

longitudinal para a viga de referência. 

Diâmetro dos 

varões 

Área de 

armadura (m2) 
ρsl (%) Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

Armadura mínima 6.70E-05 0.17 19.29 27.99 24.23 42.45 

ϕ 8 1.01E-04 0.25 20.47 36.70 38.25 43.3 

ϕ 10 1.57E-04 0.38 21.36 56.22 61.60 45 

ϕ 12 2.26E-04 0.56 22.76 82.14 87.79 43.6 

Tabela 4.18 - Principais resultados obtidos no estudo paramétrico da percentagem de armadura 

longitudinal para a viga de S1-M. 

Diâmetro dos 

varões 

Área de 

armadura (m2) 
ρsl (%) Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

Armadura mínima 6.70E-05 0.17 19.41 31.75 53.94 39.35 

ϕ 8 1.01E-04 0.25 20.71 40.11 62.74 40.55 

ϕ 10 1.57E-04 0.38 21.54 61.41 86.87 41.4 

ϕ 12 2.26E-04 0.56 22.91 86.33 110.34 39.8 

Tabela 4.19 - Principais resultados obtidos no estudo paramétrico da percentagem de armadura 

longitudinal para a viga de S2-M. 

Diâmetro dos 

varões 

Área de 

armadura (m2) 
ρsl (%) Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

Armadura mínima 6.70E-05 0.17 19.60 35.57 81.73 47.2 

ϕ 8 1.01E-04 0.25 20.64 43.72 91.49 47.7 

ϕ 10 1.57E-04 0.38 22.14 66.13 114.84 49.05 

ϕ 12 2.26E-04 0.56 23.46 91.61 140.81 47.4 

Tabela 4.20 - Principais resultados obtidos no estudo paramétrico da percentagem de armadura 

longitudinal para a viga de S3-M. 

Diâmetro dos 

varões 

Área de 

armadura (m2) 
ρsl (%) Fcr (kN) Fsy (kN) Fmax (kN) u F max (mm) 

Armadura mínima 6.70E-05 0.17 19.96 39.34 107.58 51.05 

ϕ 8 1.01E-04 0.25 21.11 46.59 118.91 51.25 

ϕ 10 1.57E-04 0.38 22.54 71.01 141.93 52.75 

ϕ 12 2.26E-04 0.56 23.95 95.50 168.72 51.50 
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Tabela 4.21 - Resultados dos acréscimos de carga obtidos para diferentes percentagens de armadura 

longitudinal. 

Percentagem 

de aço (ρsl) 

S1-M S2-M S3-M 

ΔFsy (%) ΔFmax (%) ΔFsy (%) ΔFmax (%) ΔFsy (%) ΔFmax (%) 

0.249 9.30 70.94 19.13 139.17 26.94 210.85 

0.38 9.23 54.53 17.64 86.43 26.32 130.41 

0.561 5.10 34.34 11.52 60.40 16.27 92.20 

Para uma melhor compreensão dos valores descritos na Tabela 4.21, de seguida serão 

apresentados graficamente as três Figuras (4.23, 4.24 e 4.25), respetivas a cada viga reforçada 

com CFRP (S1-M, S2-M e S3-M). Será possível analisar quais as alterações que ocorreram nos 

acréscimos de carga de cedência de armaduras e no acréscimo de carga máxima resistente das 

vigas, quando é aumentada a percentagem de armadura longitudinal de tração. 

 

Figura 4.23 - Percentagem de acréscimos de carga de cedência de armaduras e carga máxima da viga 

S1-M. 

 

Figura 4.24 - Percentagem de acréscimos de carga de cedência de armaduras e carga máxima da viga 

S2-M. 
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Figura 4.25 - Percentagem de acréscimos de carga de cedência de armaduras e carga máxima da viga 

S3-M. 

Analisando todos os resultados apresentados, podem-se obter as seguintes conclusões 

relativamente à influência da percentagem de armaduras longitudinais de tração nas vigas de 

betão armado, reforçadas com laminados de CFRP: 

 Quanto maior for a percentagem de armadura longitudinal de tração, maior será a carga de 

início de fendilhação do betão, maior será a carga de cedência das armaduras e maior será a 

carga máxima resistente da viga, para as quatro vigas em estudo. (Tabela4.17, 4.18, 4.19 e 

4.20); 

 Quanto maior for a percentagem de armadura longitudinal de tração utilizada, menor serão 

os acréscimos de carga de cedência das armaduras e carga máxima resistente, comparando 

os valores das vigas reforçadas com a viga de referência (Figuras 4.23, 4.24 e 4.25); 

 Como se pode observar nas Figuras 4.23, 4.24 e 4.25, as curvas referentes ao acréscimo de 

carga máxima tendem para uma assimptota, isto é, a partir de uma determinada percentagem 

de armadura longitudinal de tração, o acréscimo de carga máxima será constante. 
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Capítulo 5 
Considerações finais 

A realização deste trabalho teve como um dos objetivos proceder à modelação do 

comportamento de vigas de betão armado reforçadas à flexão com laminados de CFRP 

inseridos (técnica NSM), ensaiadas experimentalmente no Laboratório de Estruturas (LEST) 

do Departamento de Engenharia Civil da Universidade do Minho. Para a referida modelação 

foi usado o software de elementos finitos femix e o GID. Além disso, após a calibração do 

modelo numérico, foi efetuado um estudo paramétrico com o objetivo de avaliar a influência 

dos seguintes parâmetros na eficácia da técnica NSM com laminados de CFRP no reforço à 

flexão de vigas de betão armado: classe de resistência do betão, percentagem de armadura 

longitudinal existente e percentagem de reforço de CFRP. No âmbito desta dissertação foi 

também apresentado todo o procedimento realizado relativo à utilização dos softwares 

anteriormente referidos tendo em conta os objetivos da dissertação.  

No presente capítulo são apresentadas as principais conclusões da investigação realizada no 

âmbito da presente dissertação e algumas sugestões para desenvolvimento futuro. 

5.1 - Conclusões Gerais 

5.1.1 - Modelação do comportamento de vigas de betão armado reforçadas à flexão com 

laminados de CFRP inseridos e calibração do modelo numérico 

Por forma a modelar o comportamento de vigas de betão armado reforçadas à flexão com 

laminados de CFRP inseridos, houve numa primeira fase, necessidade de definir o nível de 

refinamento da malha a adotar, tendo sido escolhido o nível de refinamento intermédio dos três 

que foram analisados (reduzido, intermédio e elevado). O grau de refinamento intermédio foi o 

que conduziu a menores erros entre valores numéricos e experimentais, assim como obteve um 

tempo de execução do femix aceitável. No entanto, é de referir que o estudo sobre o nível de 

refinamento da malha permitiu concluir que as diferenças entre os três níveis de refinamento 

analisados não eram significativas. Com efeito, o erro médio para o nível de refinamento 

reduzido, intermédio e elevado foi de 2.75%, 1.42% e 2.59%, respetivamente.  Tendo como 

base a malha de elementos finitos referente ao nível de refinamento intermédio, foi definido um 

critério para a definição do número de elementos finitos a adotar em situações semelhantes às 

analisadas na presente dissertação. 
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A calibração do modelo numérico em termos de betão armado foi feita tendo como base o 

comportamento experimental da viga de referência de betão armado sem CFRP (viga REF), 

tendo-se obtido uma aproximação muito satisfatória entre o comportamento numérico e o 

comportamento experimental. No âmbito da modelação do comportamento da viga reforçada à 

flexão com um laminado de CFRP (viga S1-M) foi introduzido o efeito da ocorrência de algum 

deslizamento do reforço previamente a ocorrer a sua rotura. A simulação desta ocorrência foi 

feita por uma redução do valor do módulo de elasticidade do CFRP numa fase já avançada da 

mobilização do reforço. O nível de aproximação conseguido entre o comportamento numérico 

e o comportamento experimental desta viga foi muito satisfatório. Assim, foi possível modelar 

o comportamento de uma viga de betão armado reforçada à flexão com um laminado de CFRP 

inserido em que o modo de rotura experimental da viga foi a rotura do CFRP. As características 

do laminado de CFRP usadas na modelação da viga S1-M foram utilizadas nas restantes vigas 

analisadas: vigas reforçadas com dois (viga S2-M) e três (viga S3-M) laminados de CFRP 

inseridos, em que o modo de rotura experimental foi o destacamento do CFRP. Esta estratégia 

não garantiu o mesmo nível de aproximação entre o numérico e o experimental para as vigas 

S2-M e S3-M. Concretamente, o nível de aproximação entre o numérico registado nestas duas 

vigas foi muito satisfatório com a exceção da parte final das curvas de comportamento força vs. 

flecha a meio-vão, que é justificado pelo facto de numericamente o modo de rotura ter sido a 

rotura do CFRP e experimentalmente o modo de rotura ter sido o destacamento do CFRP. Para 

simular o destacamento seria necessário elaborar uma micromodelação na zona de interface 

entre os laminados de CFRP, resina epoxy e betão de recobrimento, que não foi realizado no 

âmbito desta dissertação. 

Em face do exposto, com o estudo realizado foi possível modelar com bastante precisão o 

comportamento da viga de referência sem CFRP e da viga reforçada com CFRP em que o modo 

de rotura experimental foi a rotura do CFRP. No caso das vigas reforçadas com CFRP em que 

o modo de rotura experimental foi o destacamento do CFRP, foi possível ter uma aproximação 

muito satisfatória em termos de serviço, contrariamente ao que se verificou na fase de rotura, 

em virtude de numericamente não se ter obtido o modo de rotura experimental (destacamento 

do CFRP) mas sim a rotura do CFRP. 

5.1.2 - Estudo paramétrico 

Tendo como base a calibração do modelo numérico anteriormente referida foi realizado um 

estudo paramétrico por forma a avaliar a influência da classe de resistência do betão, da 

percentagem de armadura longitudinal existente e da percentagem de reforço de CFRP na 



Considerações finais 89 

 

 

 

eficácia da técnica NSM com laminados de CFRP no reforço à flexão de vigas de betão armado. 

Neste contexto os resultados obtidos devem ser analisados considerando que, numericamente, 

o modo de rotura registado nas vigas analisadas ter sido a rotura do CFRP e que o modelo não 

está preparado para captar a rotura por destacamento do CFRP. Assim, os resultados obtidos no 

estudo paramétrico permitiram concluir o seguinte:  

i) Influência da classe de resistência do betão 

Para cada uma das quatro classes de resistência do betão analisadas (C12/15, C20/25, C30/37 

e C40/50) foi modelado o comportamento de quatro vigas: a viga de referência e três reforçadas 

à flexão com laminados de CFRP inseridos (com 1, 2 e 3 laminados). Assim, em relação às 

vigas referidas anteriormente (REF, S1-M, S2-M e S3-M), o parâmetro que variou foi a classe 

de resistência do betão. Os resultados obtidos permitiram concluir que quanto maior for a classe 

do betão das vigas, maior será a carga de fendilhação do betão e a carga de cedência das 

armaduras, independentemente da percentagem de CFRP. Em termos dos acréscimos de carga 

em relação às respetivas vigas de referência, apesar das diferenças não serem significativas, 

verificou-se que, para cada percentagem de CFRP analisada, quanto maior a classe de betão, 

menor foram os acréscimos obtidos em termos de carga de início de fendilhação e cedência das 

armaduras. Para a viga reforçada com um laminado, os acréscimos de carga de início de 

fendilhação foram 1.56%, 1.52%, 1.15% e 1.16%, respetivamente para as classes de betão 

C12/15, C20/25, C30/37 e C40/50. Para a viga com dois laminados, os acréscimos de carga de 

início de fendilhação foram 10.13%, 5.07%, 4.00% e 2.87%, respetivamente para as classes de 

betão C12/15, C20/25, C30/37 e C40/50. Para a viga reforçada com três laminados, os 

acréscimos de carga de início de fendilhação foram 15.03%, 6.65%, 5.23% e 6.41%, 

respetivamente para as classes de betão C12/15, C20/25, C30/37 e C40/50. Para a viga 

reforçada com um laminado, os acréscimos de carga de cedência das armaduras foram 8.44%, 

7.77%, 6.86% e 5.96%, respetivamente para as classes de betão C12/15, C20/25, C30/37 e 

C40/50. Para a viga com dois laminados, os acréscimos de carga de cedência das armaduras 

foram 16.71%, 16.18%, 15.79% e 14.95%, respetivamente para as classes de betão C12/15, 

C20/25, C30/37 e C40/50. Para a viga reforçada com três laminados, os acréscimos de carga de 

cedência das armaduras foram 25.08%, 25.02%, 24.91% e 23.63%, respetivamente para as 

classes de betão C12/15, C20/25, C30/37 e C40/50. 

Atendendo a que o modelo numérico não consegue ter em conta o modo de rotura por 

destacamento do CFRP e, como neste modo de rotura a resistência do betão é preponderante, 

os resultados obtidos para a carga máxima estão condicionados por este facto (o modo de rotura 
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obtido numericamente para todas as vigas, independentemente da classe de resistência do betão) 

foi a rotura do CFRP. 

ii)  Influência da percentagem de armadura longitudinal 

Para cada uma das três percentagens de armadura longitudinal analisadas (0.249%, 0.38% e 

0.561%) foi modelado o comportamento de quatro vigas: a viga de referência e três reforçadas 

à flexão com laminados de CFRP inseridos (com 1, 2 e 3 laminados). Assim, em relação às 

vigas referidas anteriormente (REF, S1-M, S2-M e S3-M), o parâmetro que variou foi a 

quantidade armadura longitudinal na face tracionada. Os resultados obtidos permitiram concluir 

que quanto maior for a percentagem de armadura longitudinal de tração, maior será a carga de 

início de fendilhação do betão, maior será a carga de cedência das armaduras e maior será a 

carga máxima resistente da viga, independentemente da percentagem de CFRP. Em termos dos 

acréscimos de carga em relação às respetivas vigas de referência, verificou-se que quanto maior 

for a percentagem de armadura longitudinal de tração utilizada, menores serão os acréscimos 

de carga de cedência das armaduras e carga máxima resistente. No caso da viga reforçada com 

um laminado, para as percentagens de armadura longitudinal de 0.249%, 0.38% e 0.561%, os 

acréscimos de carga de cedência das armaduras foram 9.30%, 9.23% e 5.10%, respetivamente, 

e os acréscimos de carga máxima foram 70.94%, 54.53% e 34.34%, respetivamente. No caso 

da viga reforçada com dois laminados, para as percentagens de armadura longitudinal de 

0.249%, 0.38% e 0.561%, os acréscimos de carga de cedência das armaduras foram 19.13%, 

17.64% e 11.52%, respetivamente, e os acréscimos de carga máxima foram 139.17%, 86.43% 

e 60.40%, respetivamente. No caso da viga reforçada com três laminados, para as percentagens 

de armadura longitudinal de 0.249%, 0.38% e 0.561%, os acréscimos de carga de cedência das 

armaduras foram 26.94%, 26.32% e 16.27%, respetivamente, e os acréscimos de carga máxima 

foram 210.85%, 130.41% e 92.20%, respetivamente. 

iii) Influência da percentagem de CFRP 

Além das vigas com 1, 2 e 3 laminados, neste estudo paramétrico procedeu-se à modelação de 

uma viga reforçada com 4 laminados. Os resultados obtidos na análise do efeito da percentagem 

de CFRP permitiram concluir que o aumento da percentagem de reforço de CFRP, provocou 

uma alteração muito reduzida na carga de início de fendilhação do betão. Em termos dos 

acréscimos de carga em relação às respetivas vigas de referência, verificou-se que com o 

aumento da percentagem de reforço CFRP, os acréscimos de carga de cedência das armaduras 

e os acréscimos de carga máxima também aumentaram. Os acréscimos de carga de cedência 
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das armaduras foram de 13.67%, 24.17%, 35.26% e 45.83%, respetivamente para valores da 

percentagem de CFRP de 0.03%, 0.06%, 0.09% e 0.12%. Os acréscimos de carga máxima 

foram de 40.14%, 86.43%, 130.41 % e 174.76%, respetivamente para valores da percentagem 

de CFRP de 0.03%, 0.06%, 0.09% e 0.12%.  

Independentemente da classe de resistência do betão, da percentagem de armadura longitudinal 

e da percentagem do reforço de CFRP, os acréscimos de carga máxima foram bastantes 

superiores aos acréscimos de carga de início de fendilhação e aos acréscimos da carga de 

cedência das armaduras.  

 5.2 - Desenvolvimentos Futuros 

Após o desenvolvimento desta dissertação, pode-se afirmar que, no geral, os objetivos 

propostos no planeamento inicial foram devidamente cumpridos. No entanto, em função das 

conclusões gerais anteriormente referidas devem ser feitas melhorias ao nível da modelação 

efetuada. Neste contexto apresentam-se sugestões para desenvolvimentos futuros: 

 Definição de modelo numérico que permita considerar a possibilidade de numa viga de 

betão armado reforçada à flexão com laminados de CFRP inseridos, poder ocorrer a rotura 

prematura por destacamento do CFRP; 

 Avaliar a influência de outros parâmetros na eficácia da técnica de reforço em análise nesta 

dissertação, como por exemplo as propriedades do CFRP e a existência de um nível de dano 

na estrutura previamente à aplicação do reforço de CFRP; 

 Modelação do comportamento de elementos de betão armado reforçados à flexão com 

laminados de CFRP inseridos com um determinado nível de pré-tensão. Realização de 

estudo paramétrico para avaliar os parâmetros que mais influenciam a técnica NSM com 

laminados de CFRP pré-tensionados. 

Quando uma estrutura de betão armado está sujeita a uma pré-tensão nos laminados de CFRP, 

a melhor opção para introduzir corretamente a pré-tensão nestes elementos, usando o software 

de cálculo femix, é sujeitá-los a uma determinada variação de temperatura, calculada pela 

expressão 5.1. Esta expressão foi deduzida utilizando as expressões 5.2, 5.3 e 5.4. 

∆𝑇 =
𝜎

𝐸.𝛼
                                                               (5.1)   
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∆𝐿

𝐿
= 𝛼. ∆𝑇                                                                             (5.2) 

𝜀 =
∆𝐿

𝐿
                                                                        (5.3) 

𝜎 = 𝐸. 𝜀                                                                                (5.4) 

Na expressão 5.1 tem-se que: 

 ∆𝑇: Variação de temperatura (°C); 

 𝜎: Valor da pré-tensão a instalar nos laminados de CFRP (MPa); 

 𝐸: Módulo de elasticidade do CFRP (MPa); 

 𝛼: Coeficiente de dilatação térmica (°C). 

Exemplo referente às lajes S2L-20 e S2L-40 do estudo de Dias et al. (2014): o cálculo da 

variação de temperatura necessária a utilizar nos laminados CFRP, para aplicar uma pré-tensão 

de 20% e 40% nas lajes S2L-20 e S2L-40, respetivamente, está representado na Tabela 5.1. 

Tabela 5.1 - Cálculo da variação de temperatura necessária para simular a pré-tensão nos laminados de 

CFRP. 

Lajes σ (MPa) E (MPa) α (°C) ΔT(°C) 

S2L-20 0.2*3165=633 175000 1*10-5 -361.714 

S2L-40 0.4*3165=1266 175000 1*10-5 -723.429 

Para a laje S2L-20, deve ser aplicada uma variação de temperatura nos laminados de CFRP de 

-361.714 °C, enquanto que para a laje S2L-40, deve ser aplicada uma variação de temperatura 

de -723.429 °C, de modo a efetuar a simulação da presença de pré-esforço nos laminados de 

CFRP. As variações de temperaturas referidas serão negativas, uma vez que se trata de pré-

esforço. 
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